Release Notes - OVIS 6.0

HP OpenView Internet Services 6.0

Release Notes J4510-88031

April 28, 2005

This document provides an overview of the changes made to HP OpenView Internet Services (OVIS) for the
6.0 release. It contains important information not included in the manuals or in online help.
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What's New in OVIS 6.0

Before You Install

Installation Notes

Known Problems, Limitations, and Workarounds
Verified Environments

Integration with Other OpenView Solutions
Local Language Support

Support

Legal Notices

HP OpenView Internet Services is copyrighted and licensed by Hewlett-Packard Company. Please refer to the
licensing agreements on the installation media.

Announcements

The HP OpenView Internet Services team is pleased to bring you this newest release of OVIS - showcasing
a completely new Dashboard, new troubleshooting aids (TIPs), and a host of additional features! Please
take a few minutes to review the What's New in OVIS 6.0 section below for a complete overview of all the

features included in this release.

OVIS Probe Builder 2.1 is releasing soon after OVIS 6.0. We recommend customers update to Probe
Builder 2.1 to take advantage of the latest features. For more information regarding the OVIS Probe
Builder, refer to the following URL: http://devresource.hp.com/drc/unifieddev/probe.jsp

. The following platforms and functionality will be obsoleted in the next release of OVIS:
o Linux RedHat - 8.X and 9.X
o HP-UX 11.0
o Windows 2000
o Oracle 8.X and 9.0

o Service Level Agreements functionality (SLASs)
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o NNM map integration (SNMP forwarding of messages will continue to be supported)

o Dial probe on HP-UX

What's New in OVIS 6.0

IMPORTANT NOTE: There are increased hardware requirements (2 GHz or more CPU, 1 GB or more
memory and 600 MB of disk space initially) to support new OVIS 6.0 capabilities.

In the OVIS 6.0 release you will find the following new features and enhancements:

DASHBOARD
All new Dashboard - with rapid tree navigation, service level objective based system health display, tool
tips capability, and more.

. Launch our new troubleshooting system for rapid problem isolation from the Dashboard.

User profiles - view multiple customers or specified service groups with one login.
TROUBLESHOOTING INSIGHT PACKAGES (TIPS)

TIPs contains a rich set of troubleshooting TIPs and Commands. Use the default configuration to experience
the following features:

. Execute troubleshooting commands on demand against target systems and alarms on remote probe
systems in a distributed environment.

Analyze command results quickly. Keywords are highlighted, predefined rules hide irrelevant information,
and the overall success or failure of each command is displayed.

. Automatically trigger troubleshooting commands at the time a problem occurs.

See a screen shot of the IE-mode HTTP_TRANS probe error if "Capture Window on Error (IE)" is
configured.

. Configure and execute troubleshooting commands on all supported probe system platforms.

. Create TIPs to execute custom scripts developed in Perl, VBScript, JScript, Windows and UNIX/LINUX shell
script, Expect, WMI scripts, etc.

. Leverage third-party troubleshooting commands to analyze monitored service alarms.

. Protect your data and systems with firewall-friendly communication, operator authentication, and
confidentiality of commands and command results.

Refer to the Dashboard and TIPs What's New documents in the OVIS CD installation folder (or <install dir>
\help\iops\c\OVIS 60-dashboard.pdf and ovis60-tips.pdf) to get more information about the new Dashboard
and Troubleshooting Insight Packages.
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ALARMS and NOTIFICATIONS

Notification system to send email or execute a command when an alarm occurs

Ability to send traps to multiple systems
CONFIGURATION MANAGER

. Copy and paste
. Mass target or password update
Quicker startup
"Test on Management Server" for HTTP_TRANS targets supported for Windows XP and 2003 only

Status now gives immediate "Disabled" indication and better Service Target Availability indicators
NEW PROBES

. TFTP
. TCP network performance
UDP network performance

SYS_BASIC_WMI to collect basic Windows system performance metrics
PROBE ENHANCEMENTS

. Script probe - supports eight user defined metrics and multi-step transactions
. HTTP_TRANS probe
o ability to save cookies in a file and reuse them (for example, to bypass a transaction login step)
o "Run As" a configured user login
o command line execution enhancement (Windows XP and 2003 only)
o allows Probe Re-execution through TIPs (Windows XP and 2003 only)
o ability to upload a file from an HTML form
. HTTPS probe - support 4096-bit encryption web servers
HTTP and HTTPS probe - Faster retrieval of very large web pages
o ability to reuse cookies via a save file (for example, to bypass a transaction login step)
User configurable LABEL optionally replaces target name for the following probes:
o HTTP and HTTPS
o DHCP
o Exchange

o LDAP
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o IMAP

o POP3

o SMTP

o Mail Round Trip
o ICMP

o ODBC

o SOAP

SAP probes - supports group logins
DATA MANAGEMENT

. Remove "unavailable" data from the data base via ovisdbclean utility
. Rename customers and service groups, and the associated data, via ovisdatarename utility

Added configuration capability to the Ul to prevent data loss when Reporter data base is down for
extended periods of time

. Ability to set retain days for alarms
AUTOMATION CAPABILITIES
Programmatically enable/disable a target, service group, or customer via iopsload
NEW and IMPROVED INTEGRATION
SIM (HP Systems Insight Manager) - if you are not familiar with SIM, see http://h18013.www1.hp.com/

products/servers/management/hpsim/index.html
for more information.

OVIS SNMP MIB for easier integration into other SNMP event managers

Enhanced OVIS Alarms (3) template. It now works if duplicate suppression is enabled in OVO.

REPORTING CHANGES

. Update of Crystal 8.5 to Crystal 10 libraries may require changes with custom reports or custom logos in
reports. See Updating Crystal Report Templates for information about updating report templates to

Crystal 10.

SUPPORT

. Perfstat utility enhanced to display new OVIS modules and services, and to display more OpenView
products

Logstat utility enhanced to collect new logs and information to help diagnose problems in new facilities

LICENSING
Page 4


http://h18013.www1.hp.com/products/servers/management/hpsim/index.html
http://h18013.www1.hp.com/products/servers/management/hpsim/index.html

Release Notes - OVIS 6.0

. Enforce Custom Target licenses. Customer using probes created with either OVIS Probe Builder or OVIS
Custom Probe SDK must ensure proper license keys are installed.

Directory Layout Changes

The probes directory layout has changed. The script probe (probeScript), IE mode HTTP_TRANS
(probeHttpTrans2) and custom probes are affected by these changes:

. Scripts distributed from newconfig\distrib are now placed under bin\instrumentation\probe\scripts
(previously they were placed under \probes\scripts). The script probe switches to bin\instrumentation
\probe before executing a script. There should be no modifications necessary to the script unless the
script relies on components that are not found under bin\instrumentation\probe\scripts or the PATH
environment variable.

All OpenView delivered probes are now installed under the bin directory. Custom probes should continue
to be installed under the probes directory in order to avoid file name clashes with OpenView binaries. The
scheduler is able to execute probes from both directory locations.

Certain custom scripts used by the IE mode HTTP_TRANS probe might not work (e.g. perl scripts) and the
command line for the script must be adjusted. The scripts can be distributed (see above) or installed in
the probes directory.

NOTE: If you are upgrading from OVIS 4.5, 5.0 or 5.2 you can see what's new in these interim releases (and
thus also available to you in the OVIS 6.0 release) by viewing the release notes for each of these releases on
the following web site: http://ovweb.external.hp.com/lpe/doc_serv/

Before You Install

Before you install you should read the section for All Users below. In addition, there are different
considerations for updates to existing OVIS installations covered in the section for Update Users. These are
referred to as New and Update (below). Also see the Security Alert section that follows. And see the section on

Using OVIS 6 with other OpenView Products.

All Users

1. Check the "Installation Prerequisites" section in Chapter 2 of the OVIS User's Reference Guide to make
sure you have the required hardware and software for both the management server and probe
systems. UPDATE users need to check this since minimum requirements and supported platforms and
operating system versions will change over time.

2. Windows Server 2003 WARNING: By default Windows Server 2003 systems have Internet Explorer
Enhanced Security enabled with very restrictive access. You must change the configuration to prevent
all basic OVIS communication functions from failing with various HTTP errors. See problem
QXCR1000050345 in the “Known Problems” section “Communications” subsection for Workaround
information

3. Check the Microsoft web site for the latest service pack and hot fixes to keep your systems up to date
with known security fixes.
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4.

10.

11.

12.

13.

Check the "Integration with other OpenView Products" section of these release notes to make sure you
are integrating with the correct versions and patch levels for other OpenView products. UPDATE users
need to check this since these versions may change from one OVIS release to another.

Installation of OVIS and its integration components is not supported over Terminal Services.

Before you Update, disable any agents which automatically start OVIS services, for example, the BMC
Patrol Agent or the NetlQ Agent.

With OVIS 6.0 we now enforce both Standard target licenses and Custom Target licenses. Customer
using probes created with either OVIS Probe Builder or OVIS Custom Probe SDK must ensure proper
license keys are installed.

If custom probes were configured in a previous release of OVIS without the correct custom probe
license, the custom probes will be deactivated (see QXCR1000229952). In order to activate the 60 day
trial for the custom probes, open up the Configuration Manager and select File > Save Probe
Configuration or select the Save icon.

. A number of server ports are now used with OVIS 6.0. During installation, the following default ports

are used in the Tomcat Servlet Container Configuration:

8080 (HTTP - OVIS Dashboard)
8009 (JK2 - AJP communication via Apache)
8005 (Shutdown)

If any of these ports are already taken, the installation program will prompt you to select a different
port. In addition you may change the ports and other ports used by OVIS, later, after installation. See
the OVIS User's Reference Guide for more information.

Korn shell (ksh) is required for the UNIX remote probe software installation scripts.

Choosing 'Operations for Windows Integration’ install from the OVIS CD install menu might give the
error The Msiexec.exe application could not be located. Please insert the next disk and press OK to
continue.

Workaround: The cause of the problem is that install is being run in Terminal Services EXECUTE
mode. Use Add/Remove programs in the Control Panel, select Add New Programs. Select the CD or
Floppy button, select Next on the Install Program from Floppy Disk or CD-ROM dialog, select RunSetup.
cmd and select the Finish button to launch the Install Internet Service menu.

You may also change the run mode for the server to INSTALL by using ‘change user /INSTALL'
command from a command prompt so that the Terminal Server run mode is switched during the install
of OVIS. If you change the user command to switch the run mode, please remember to run the run
mode back to EXECUTE after the installation with the command ‘change user /EXECUTE. You can use
the command ‘change user /QUERY to determine the current run mode.

After upgrading, if the DNS server resolves a probe location name to something other than how it was
configured in the Configuration Manager, you will see both systems listed in the Dashboard as probe
locations until the old data has rolled out of the time filter. For example, if your time filter in the
Dashboard is set to 4 hours, you will see two systems listed as probe locations until the 4 hours after
you upgrade. If you delete a probe location from the configuration manager and then add it back you
will see this same behavior.

If you are creating custom reports for standard probes the report name must now be prefixed by
'IOPS_' plus the probe type name. For example, if you are adding a report for HTTP probe, the report
name must be in the form 'lOPS_HTTP_MyNewReport'.

PROBENAME: HTTP
DESCRIPTION: HTTP - Web Pages
PROBEMETRICLIST: IOPS_HTTP
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END_PROBENAME:

REPORT: IOPS_HTTP_MyNewReport
CATEGORY: 190 Internet Services
ALL_TEMPLATE: reports\IOps\a_IOps_Http.rpt
HTML_DIRECTORY: webpages\a _iops_http
DESCRIPTION: HTTP - Web Pages

MAXTIME: 10

FAMILY: "Internet Services"

END_REPORT:

GROUPREPORT: I0PS_HTTP_MyNewReport
GROUP: ALL
END_GROUPREPORT:

If you are creating custom reports for custom probes then the report name must be equal to
the custom probe name prefixed by IOPS__ (see the Custom Probe APl Guide for more
information).

14. With the remote probe Windows silent install there is a new TIPS_PORT variable.
15. Note that a reboot is required after installation on the server.

16. OVOW integration with OVIS 6.0 requires OVOW agent version 7.27 or higher on the OVIS
Management Server (patch OVOW_00059).

Updating Crystal Report Templates:

The templates of Crystal 8.5 (or earlier version), when used with Reporter 3.6, (which uses Crystal 10
binaries) may break the HTML files created by the ‘Repcrys’ module. You may have to change the 8.5
templates based on the issues encountered. Please note that all the out-of-the-box Crystal Reports templates
that accompany Reporter 3.6 Full are properly converted and should work fine without any issues.

Note: Crystal 10 has backward compatibility problems with earlier Crystal versions. The modified templates for
OVOW, and SPIs are available at ftp.hp.com/pub/ovreporter. You can download the readmefirst.txt file to
check for updates.

The following changes are applicable for users who wish to use their customized Crystal 8.5 templates with
Reporter 3.6 and OVIS 6.0.

All the reports can be edited with Crystal Reports 8.5 with the following modifications in order to be able to
support Crystal 8.5 and Crystal 10 from the same templates. If it is required to support text fields longer than
254 characters (or 127 Japanese characters), the reports must be edited using Crystal 10 as there is no way
to do this with Crystal Reports 8.5.

Problem: Crystal 10 does not truncate fields based on the field length defined in the report template. So
in the exported HTML files, if the data in the database is longer than the field length defined in the report
template, the data will overlap with the neighboring field.

Solution: Modify the templates to validate all of the fields to make sure the field defined in the report
template is at least the same size as the field in the Reporter database. It might not be always possible to
have the full length of the database fields displayed, as e.g. object or application fields with 254
characters would not leave any further space in the same line to display further information. If possible,
the according field should be configured with the "Can Grow" option, so that the field automatically
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extends vertically. If this messes up the report design, it is possible to set the "Can Grow" option with a
maximum number of lines =1. In this case, Crystal Reports10 truncates data again, but only for formula
fields and with a different mechanism. So plain database field objects must be placed into a formula and it
must be checked if the new truncation mechanism does not truncate important information.

Sometimes the problem of overlapping can not be solved only using the "Can Grow" option (for example,
if there is a field with a big font size, it can overlap underlying fields despite this option). In this case the
problem field can be placed into a separate report section.

. Problem: Exported HTML reports will not have space in the LHS (left hand side).
Solution: Modify templates for LHS space manually by setting the margin for the report. Adding an
additional 1/4 inch margin should solve the problem.

. Problem: The Hyperlink used to display banners is not parsed and hence becomes visible text. The ‘less-
than’ and ‘greater-than’ symbols are translated to character entities, which prevent the text from being
recognized as HTML.

Solution: The solution is to use OLE object linking to get some minimal of linking of banners working with
Crystal Reports 8.5 and Crystal Reports 10. Instead of embedding the banner in the report, you have to
insert an OLE Link to the banner graphic in the report. This requires to have a fixed location and size in
the banner files and customers can only exchange with banners of an equal size. Also, If customers want
to include their own banners in the reports, they will need to purchase Crystal Reports 10 and modify the
reports to include their banners. As they include the banner, they can size the banner properly inside the
report.

. Problem: Boolean or single bit flag fields in the database (such as the SYSTEMS table’s EXCLUDE column)
might not migrate correctly to Crystal Reports 10. The template seems to expect a numeric value in a
selection formula that should evaluate to a Boolean.

Solution: Bit flags cannot be used with Crystal Reports10 and Oracle. Oracle knows only the numeric data
type and accordingly Crystal Reports10's data type checking will cause an error if true/false checks are
used. Therefore such fields must be implemented as Integer across all databases and the reports should
use "field=0" checking. Using " =0" will work for both Oracle (numeric field) and SQL Server (bit field).

. Problem: Crystal Queries are no longer supported with Crystal Reports10.
Solution: The reports have to be changed to work without queries. If this is not possible (example, if a
UNION must be used without any other leading table) you might be forced to create views in the database
to cover this functionality.

. Problem: Every run of Repcys binary creates a set of files with distinct GUIDs as filename and ‘.png’ as
extension in the directories that have the generated HTML files. The user would need only the latest set of
‘.png’ files to view the generated HTML files.

Solution: Schedule ‘Repmaint —clean’ so that the unwanted ‘.png’ files can be removed. It should be
scheduled well after RepCyrs has finished generating reports.

. Problem: When Crystal 8.5 templates are exported (using Reporter 3.6) with 'Page Break' option set, the
‘Navigational' links in them will be broken. This is because there is a difference in the name of .html files
that get generated when exported using Crystal 8.5 and Crystal 10.

Solution: Reporter 3.6 uses Crystal 10 and on exporting with page break, the html files are named as
default.ntml where n=1,2,3..k. [Whereas, the previous version of Reporter, which uses Crystal 8.5, the
generated html files used be named as default.htm and default.htm where n=1,2,3...k] Hence Crystal
Reports 10 designer needs to be used to make the appropriate changes to the links in the report
template.

. Problem: Formulas with the global variables and running total fields cannot be used in charts, maps. or
cross-tabs.
Solution: In Crystal 10, this is no longer possible. To solve this problem the report needs to be
redesigned to work without the use of global variables in charts.

Problem: Crystal Reports10 aligns but does not correctly align fields with borders.
Solution: Remove the border from the field formatting and place an empty field with border on top of the
value field.
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. Problem: Crystal Report 10 cuts the blank spaces or adds empty sections at the bottom of the
report.
Solution: If the last line of the exported report is not completely visible in Internet Explorer, insert a
blank text field in the report footer section. Crystal Reports10 will export the blank section at the end of
the report according to the height of the inserted text field.

Update Users

1. Before upgrading, please be sure to review the Dashboard and TIPs What's New documents located in
the OVIS CD-ROM installation folder (or <install dir=>\help\iops\c\OVIS 60-dashboard.pdf and ovis60-
tips.pdf) to get more information about the new Dashboard and Troubleshooting Insight Packages.

2. When upgrading an existing OVIS Management Server and Windows or Unix remote probe systems
from OVIS 4.5 or greater to OVIS 6.0, DO NOT uninstall the pre-existing version before installing the
newer version. This can cause the loss of critical settings and data. You should instead install OVIS
6.0 over the previous version.

See Step 11 Updating the NNM Integration Component and Step 12 Updating the OVO Unix Integration
Component below for important information on removing previous packages prior to updating to the
6.0 versions on the integration components.

3. A direct upgrade from either the 3.X or 4.0 release to OVIS 6.0 is NOT supported. If you are using
OVIS 3.X or 4.0, contact your OpenView Sales Representative or reseller for assistance in converting
your licenses to the proper structure and to the new license technology implemented starting in OVIS
4.5.

4. Before installing, remove any OVIS patches listed in Add/Remove programs. If this is not done before
installing OVIS 6.0, patches may be removed later without impacting the current install.

5. Update both the management server and the remote probe system software at the same time to keep
data and configuration synchronized.

6. Do not shut down or unlink the database during installation since table modifications and probe
additions are done during this process.

7. For Oracle database users, it is recommended that you consult with your DBA before installation on the
following issues:

. Make sure there is sufficient free space in the table spaces that hold rollback segments, the
Reporter database, and indexes. Depending on the amount of data in the tables, extra
capacity may have to be added to the indexes, table space and the roll back segments.
Changes in OVIS 6.0 have the potential to increase sizing by as much as 30%. The
installation will fail if the required database updates do not complete.

8. The following note is especially critical for customers updating from OVIS 4.5 and 5.0. For Oracle or
SQL data base users, check with your DBA to make sure they enact maintenance procedures for the
new indexes in the data tables. The installation added indexes for the fields DATETIME,
CUSTOMER_NAME, SERVICE_NAME, and PROBENAME on the table IOPS_PROBE_DATA,
IOPS_PROBE_DATA_CACHE, IOPS_PROBE_DATA_DAILY and indexes for the fields DATETIME,
CUSTOMER, SERVICENAME, PROBENAME on the tables IOPS_DETAIL_DATA,

IOPS_DETAIL_DATA HOURLY, and IOPS_DETAIL_DATA DAILY. Note also that for new data bases the
SYSTEMNAME field is no longer indexed because OVIS no longer uses it. You may wish to have your
data base administrator delete that index on any data of the data tables mentioned above in which it
appears.

9. If the logon account for the "HP Internet Services" service was changed from the Local System account
to a user account, the logon account will be changed back to the "Local System" account during the
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10.

11.

12.

13.

14.

software installation.

After the upgrade is complete, you may reset the logon account to the previous setting via the Start >
Settings = Control Panel = Administrative Tools > Services selection. Right-click "HP Internet
Services" in the list of services and select Properties. Then select the Log On tab and check "This
account" and browse to select the desired logon user account.

For Remote Probes: After you have installed or updated the software on all remote probe systems, you
must "Save Configuration™ in the OVIS Configuration Manager in order to collect data on those remote
probe systems. Note: installing OVIS server on top of remote probes is not supported.

If you are using NNM Integration, you should first remove the existing integration components and
then update to the new version of OVIS 6.0 integration software on the NNM Console. This will update
the integration in general.

If you use OVO UNIX integration, prior to updating to the OVIS 6.0 OVO UNIX integration component,
be sure to remove all previous templates and associated template groups. Also note that the OVO/U
integration has to be updated on the OVO Server. See "Integration with OpenView Operations for Unix"
section in the User's Reference Guide for more information.

Note that there is a new tracing utility for the new Dashboard and TIPs functions.

Please refer to the Known Problems and Workarounds section of these Release Notes for additional
information that may pertain to your installation.

Security Alert

ORPHANED “OVOPS” INSTANCE: When you switch from the default "OVOPS" instance of the Reporter
database to either Oracle or MS SQL Server 2000, the normal procedure leaves the default “OVOPS” instance
in place. This allows the flexibility of switching the database back to that instance via a simple ODBC
configuration if needed. This instance, though not in use by OVIS, may be vulnerable to the “Slammer” worm
or other viruses. To eliminate this vulnerability:

Delete the instance. This is the preferable option if you know the instance is not in use by OVIS or another
product such as Reporter or Operations for Windows (OVO). It also prevents future vulnerabilities this
instance may have. The procedure for this is to:

Copy the repair.vbs file from the OVIS media CD under \ Suppor t\ Support Tool s to a local
empty folder on the system.

Open a command prompt to the location where the file was copied and enter the following command
line:
cscript repair.vbs -renove //T:999

This starts up a menu where you can select/un-select components for removal.

Click the Un-select all button and then select only the "Microsoft SQL Server Desktop Engine"
checkbox.

Click the Remove Components button and wait for the uninstall to complete.

Click the Exit button to terminate the script.

WARNING: If the Delete Instance procedure above does not successfully complete for any
reason, there is an additional procedure on the CD in the Support\Support Tools directory.
This procedure should only be used as a last resort. It is recommended to contact a support
representative before using it.
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If you have chosen to switch from the default MSDE 2000 database to SQL 2000, it is your responsibility to
check that the Microsoft SQL Server 2000 Service Pack version is updated for the appropriate security level.

Using OVIS 6 with other OpenView Products

Port Conflicts with other OpenView Products and Applications Using Tomcat:

If you find there are port conflicts with OVIS and other OpenView products when installed on the same
system, you can change the OVIS Dashboard ports (Tomcat) on the OVIS Management Server. See the
example below (the port numbers shown below are just examples):

cd <install dir>\bin

ovc -stop ovtomcatA

cscript /nologo ovtomcatCtl.vbs -setshutdownport 9005
cscript /nologo ovtomcatCtl.vbs -sethttpport 9080
cscript /nologo ovtomcatCtl.vbs -setjk2port 9007

ovc -start ovtomcatA

You can use net stat -an to see which ports are taken. You could also use the following command to check if
a port is in use: cscri pt/ nol ogo ovtontatctl.vbs -checkport 9005.

Note, after changing the ports, you need to also configure the http port that you chose above in the OVIS
Configuration Manager File > Configure > Web Server Properties dialog. Enter the port number in the Tomcat
- Dashboard (Web Server) Port field.

OVO/Windows Coexistence: Installing OVIS on a clustered OVO for Windows server (7.5 or higher) is not
supported. However you can install the OVIS-OVOW integration component into this environment.

OVPM Coexistence: Installing OVPM 5.0 UNIX on top of the OVIS 6.0 remote probes may cause ovc not to
start. Start ovc manually after the OVPM install (ovc -start).

Installation Notes

Installation Instructions

IMPORTANT NOTE: There are increased hardware requirements (2 GHz or more CPU, 1 GB or more
memory and 600 MB of disk space initially) to support new OVIS 6.0 capabilities.

Installation requirements (hardware and software requirements), as well as instructions for installing OVIS,
are documented in the OVIS User's Reference Guide provided in Adobe Acrobat (.pdf) format. The document
file is included on the product's CD media as:
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Docunent ati on\1 S _User Ref _Gui de. pdf

After installation the document can be found at:

<install dir>\help\iops\c\IS User Ref Guide. pdf

Also refer to Supported Platforms list later in the release notes.

After Installation

1. The TIPs Server uses two default ports:

o Port 8080 is the default port to communicate with TIPs Viewers (this is the default Tomcat HTTP
port used by OVIS).

o Port 6604 is the default port to communicate with TIPs Runners

These port numbers must be available for incoming communication on the TIPs Server system. If you
use a firewall, both of these ports must be open for communication.

The default communication with TIPs Runners is standard HTTP protocol. TIPs communication is more
secure when you use SSL certificate based communication. Refer to the TIPs online help, from within
the TIPs Configuration program, to understand how to re-configure the TIPs Server ports and
communication protocol, if necessary. To enable secure communications between the TIPs Runner and
TIPs Server in a firewall environment, enable port 383 on both the TIPs Server and TIPs Runner
systems. This port is required for certificate communications.

2. Use the TIPs Configuration program to verify that the TIPs Runners have been properly installed and
registered. From the TIPs Runners folder in the scope pane, you will see a list of all registered TIP
Runners. If no TIPs Runners are listed, refer to the TIPs online help to troubleshoot TIPs Runners
registration.

3. Before TIPs can be launched, OVIS must be configured with one or more service targets. Once the
service targets are available, TIPs can be launched from a service target in the OVIS Dashboard. If one
or more OVIS service level objectives are configured, TIPs can be launched from OVIS alarms as well.

Using LogStat.vbs.

Synopsis:

The LogSt at . vbs script, which is located on the OVIS Installation CD in the Support\ Support Tool s
directory or disk area (and is also installed into the <i nst al | di r >\ bi n directory), can be used in

situations where there are problems with OVIS software and you need to bundle up the status files and other
system information for support personnel.

This script creates a file called | ogst at . CAB in the [ DATADI R] \ HPOVI nst al | folder whose size will
be on the order of ten megabytes. Note that logstat compresses all the files into the CAB file.

Required software:
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This script is written in vbscript and requires the following:

. Windows Scripting Components (cscript 5.6 or higher)
. Internet Explorer 6.0 or higher

. Windows Installer Service, to execute correctly

Command Line usage:

Use wscript or cscript to execute the script. Double clicking on the file will run it as well, with the default
options. From a command line prompt window you can execute LogSt at . vbs as follows:

c:>cscript LogStat.vbs <options>

Using repair.vbs.

Synopsis:

The repai r. vbs script, which is located on the OVIS Installation CD in the Support\ Support Tool s directory

or disk area, can be used in situations where the installation has failed to uninstall or special cases where you
would like to uninstall specific components. This script can also be used to restore files that may have been
deleted through system or user intervention on the server. The script only operates after a properly installed
product is present on the system so the script cannot be used as a primary means of installation. The script
will use the existing windows installer components to determine which components can be repaired or
removed via the script. The script will also create a log in the [ DATADI Rl \ HPOVI nst al | folder that can also be

collected by | ogst at . vbs.

The repair.vbs script will require the original OVIS CD when attempting to run a repair. This is mainly because
un-versioned files must always be re-installed from the source media during a repair action. If the source
media or original install software is not available the installer will prompt you for the location of the msi file
that is currently being installed. You can then use the browse button to locate the folder SETUP on the install
source media, then further locate the folder containing the requested msi file.

The repair.vbs script needs to be copied from the OVIS Installation CD Support\Support Tools directory and
placed on the hard drive because it will create a data file that is used for determining the packages that need
to be repaired on the system. Leaving the source media in the cd-rom or in the default network share that it
was installed from, prevents the installation from prompting for the source media.

Required software:

This script is written in vbscript and requires Windows Scripting Components, Internet Explorer 5.0 or better,
and Windows Installer Service to execute correctly.

Command Line usage:

Use wscript or cscript to execute the script. Double clicking on the file will run r epai r. vbs with default
command line options.
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From a command line prompt window you can execute r epai r. vbs as follows: c: >cscript repair.vbs
<opti ons>

Options:
|—checkbox |when set enables the checkbox dialog selection. Checkbox selection is on by default.
when set disables the reboot dialog check. Reboot is enabled by default if there are
-noreboot . - .
pending deletes before or after script execution.
|—runrepair |run a repair on all products found. Automatic execution of repair is disabled by default.
|—remove |enab|es the remove option from the GUI. Remove option is disabled by default.
|—? -help |—HELP displays help message for options.

Most common usage: c:\> cscript.exe repair.vbs -renpve

Known Problems, Limitations, and Workarounds

The following areas of Internet Services are either incomplete or known to not function as expected in the
A.06.00 release.

Note that the number listed (e.g., QXCR1000230447) is the number used in OpenView's Software Support
Online web site _http://support.openview.hp.com/. A URL to the self-solve document for the QXCR is also
listed for each. If you aren't logged in to OpenView's Software Support Online web site, you will see a log in
screen first, otherwise you will link directly to the self-solve document. If for any reason the URL link does not
work, you can search the OpenView Software Support Online web site for the QXCR number.

For ease of reference the known problems listed below have been subdivided into the following sections:

Communications

. Install/Uninstall

Database
. Services

OVPM Integration

. OVTA Integration

OVO Integration

. Dashboard

Web Transaction Recorder
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. Probes

. Configuration
. TIPs Server

. TIPs Runner
. TIPs Viewer

. TIPs Configuration program

. TIPs Authentication Data Manager

. TIPs provided by HP

. TIPs Documentation

. Custom Probes SDK

. NNM Integration

Communications:

QXCR1000050345: Alarm engine fails to start on Windows Server 2003 running terminal services

Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000050345

Workaround: Internet Explorer Enhanced Security is a new feature from Microsoft to control the web sites
your users can browse on your system. When enabled (which is the default for Windows Server 2003
installations) this prevents users from browsing untrusted websites. This will also cause warnings of
potentially malicious software if you try to install OVIS software from a share. You also see this when browsing
on the local system with Internet Explorer. You can work around this problem in either of the following two
ways:

1. Disabling "Internet Explorer Enhanced Security Configuration™. This will work for local logins, but will
not work for users running the OVIS configuration manager over a Terminal Server session.

From the Control Panel, select Add/Remove Programs and then select Add/Remove Windows
Component from the left-hand pane. From the Windows Components Wizard dialog, deselect
Internet Explorer Enhanced Security Configuration, select the Next button, and then
select the Finish button to Complete the Windows Component Wizard. Then restart 11S Admin
Service.

2. Adding the sites required by OVIS to your Internet Properties Local intranet or Trusted Sites
configuration. This will work for both local and Terminal Server logins.

From the Control Panel, select Internet Options and then select the Security tab. You are
going to add sites to either your Local intranet or Trusted sites zone, depending on which is
appropriate for your desired level of security. Select the appropriate zone and then select the
Sites button. Use the resulting dialog to add both http://<hostname=> and http://<hostname=>.
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<domainname> where hostname is the name of the OVIS management server. You may also
add file://<hostname> if you wish to eliminate file browser warnings and warnings when trying
to install OVIS software from a share. Then select the OK button, and restart 11S Admin
Service.

More information on Internet Explorer Enhanced Security model on Windows Server 2003 can be found at URL
http://msdn.microsoft.com/library/default.asp?url=/workshop/security/szone/overview/esc changes.asp

InstallZ/Uninstall:

QXCR1000046440: Removal of full Reporter removes registry keys. Symptoms include OVIS Configuration
Manager unable to start with prompting for database password, and the OVIS dashboard is unavailable.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000046440

Workaround: Start the Configuration Manager and it will prompt for a DB user and password. Enter the user
and password for the database connection and most items will start working. (Typical - user: openview,
password: openview.) To correct the missing virtual directory go into 11S. Right-click on the Default Website
and add a new virtual directory HPOV_REPORTS. Set the path to <i nstal | _di r >\ dat a\ webpages. Finally
allow read, script, and execute permissions on the directory.

Alternative Method: On the original OVIS CD go into \ Support\ Support Tool s and runrepair. vbs .

Inside of repai r. vbs select only hp OpenView reporter, unselect all other installed items. Then click Repair
Components. When the repair tool completes OVIS should be back to full functionality.

QXCR1000047049: You cannot uninstall OVIS after NNM integration uninstallation on an NNM 6.4 or 6.41
system.

Software Support Online Link:_http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000047049

Workaround: Registry entry HKEY LOCAL _MACHI NE\ SOFTWARE\ Hewl et t - Packar d\ HpOvLi c-

Dependent Product Li st has an invalid value such as {E45D72D7-65EA-45F6-AA94-3C304EA91AA2}.

This GUID should be for an upgrade code of the msi package that is holding the dependency on the autopass
package. Since the GUID that is inserted is invalid, the OVIS common installer fails to uninstall. As a
workaround the value can be replaced with a valid value from another msi NNM component such as
HPOvNmMDep package: {76D04B27-5036- 49DB-B383-1165C8B2B4AF}. This should allow the OVIS installer
to continue to perform the uninstall.

QXCR1000047881: After upgrading from 4.5 (with or without patch) or 5.0 to 6.0, choosing Shutdown from
the Start menu does nothing. The menu to select Shutdown, Restart, Log off, ... does not appear.

Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000047881

Workaround: Pressing Ctrl-Alt-Delete brings up the Windows Security menu and the system can be restarted
and shut down from there.

QXCR1000047886: In OVIS releases 4.5 and earlier, an uninstall of OVIS removes customized data table
retention days settings. This is fixed in OVIS 5.0 but is provided in these release notes to make you aware
that if you uninstall 4.5 before installing 6.0 you will encounter this problem. There is no need to uninstall 4.5
prior to installing 6.0, just overinstall.

Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000047886

Workaround: Reset the retain days setting in the OVIS Configuration Manager via File > Configure >
Database = Options BEFORE scheduled maintenance runs and deletes data (typically after midnight) If you
wish to update from OVIS 4.5 to 6.0, simply do an install of OVIS 6.0 without uninstalling the previous version
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and this problem will not occur.

QXCR1000050424: Install Error 1923
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000198648
Workaround: This may be caused by an open "Services" applet. Close the "Services" applet.

QXCR1000050619: Note installation problem when agents automatically start services.
Software Support Online Link: _http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000050619
Workaround: Disable any agents which automatically start OVIS services during updates.

QXCR1000157648: Uninstallation of OVOW 7.2 causes OVIS data to disappear.

Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000157648

Workaround: The uninstallation deletes the DSN entry to the previous database and adds a new one with a
MicroSoft Access driver specified. Use the procedure below to remove that DSN and add the proper one back.
Note that you should see your existing data and configuration after successfully completing this procedure. If
the OVIS database was the default Microsoft SQL Server Desktop Engine (MSDE) database then perform the
following steps. (For Oracle and SQL server, please follow the database specific steps as described in the
OVIS Database Configuration guide.)

1. Stop IS and Reporter

net stop iisadmn /y net stop reporter

2. Launch Control Panel select Administrative Tools > Data Sources (ODBC).
a. In the ODBC Data Source Administrator, click System DSN tab.
b. Remove the Reporter DSN.
c. In the System DSN tab, create a new data source by clicking on Add.
d. In the Create New Data Source dialog select SQL Server, press Finish.

e. In the Create a New Data Source to SQL Server dialog, fill out the following fields and then
click Next: Name: Reporter, Description: Reporter, Server: <local hostname=>\0OVOPS

f. Select "With SQL Server authentication using a login ID and password entered by the user”,
enter the following login and password and click Next: Login ID: openview, Password:
openview

g. Change the default database to: Reporter

h. Click Next.

i. Click Finish.

j. Click Test Data Source and verify that connection was successful.

k. Press Okay.

3. Run Repair.vbs (from the Support directory on the OVIS CD)
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4. If above step doesn't force a reboot, Re-start reporter/iisadmn

net start w3svc
net start reporter

Note: It may take up to 1/2 hour before new data will show up in the GUI. This is due to the fact that
iopscollector.exe and iopsmaint.exe are scheduled to run 1/2 hour from the time repair.vbs was executed.

Optional: The OpenView Trace Server is no longer installed under the service menu. To install the service,
simply run <install_dir=>\bin\trcinst.exe

QXCR1000018404: Uninstalling NNM 7 when installed with OVIS, breaks OVIS Config Mgr
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000018404

Workaround: On the original OVIS CD go into \ Suppor t\ Support Tool s and runrepai r. vbs.
Inside of repair.vbs select only hp QpenVi ew i nternet services, unselect all other installed
items. Then click Repai r Conponent s . When the repair tool completes, OVIS should be back to full
functionality.

QXCR1000198648: MSDE Disk requested during install.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000198648

QXCR1000208615: 118N - remote probes installation failed on RedHat EX3.0J.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000208615

QXCR1000227126: logstat hangs when collecting event log information

Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000227126

Workaround:The work around for this issue is to not use the files_event option in logstat and to use the
event viewer to get the event logs.

QXCR1000228646: installing OVIS server on top of remote probes is not supported.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000228646

QXCR1000229952: 6.0 Upgrade needs CM Save to activate temporary license for Custom Probes.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000229952

Workaround: This problem occurs after an upgrade to OVIS 6.0. If custom probes were configured in a
previous release of OVIS without the correct custom probe license, the custom probes will be deactivated. In
order to activate the 60 day trial for the custom probes, open up the Configuration Manager and select File >
Save Probe Configuration or select the Save icon.

QXCR1000230447: Remote Probe uninstall failure if directory already removed
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000230447
Workaround: Create directory before running uninstall: mkdir -p /var/opt/OV/bin/instrumentation/probe/
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script

QXCR1000232089: InstallShield Wizard Error indicates install script error.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000232089

Workaround: Through Window Task Manager, end any iskernel.exe or knlwrap.exe processes before
installing OVIS.

No QXCR: During reporter installation, the following error dialog might be shown by the installer:

"Error 1920. Service Reporter (Reporter) failed to start. Verify that you have sufficient privileges to start
system services."

Workaround: This may be due to a failed deinstallation of a previous OpenView product. Please verify the
following:

1. In the Services control panel applet, locate HP QpenVi ew Trace Servi ce.

2. If found, determine whether the OVTr ace. exe executable shown in "Path to Executable" really exists.
If it does not, then run regedit and delete the registry entries for this service:
a. In regedit, go to

HKEY LOCAL_ MACHI NE\ SYSTEM Curr ent Cont rol Set\ Servi ces

c. Highlight entry HPOVTrace and press Delete.

d. Reboot the system and start the installation again.

QXCR1000043274: At installation, IIS sub services such as FTP and SMTP are stopped and not restarted
automatically.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000043274
Workaround: Start the services manually.

Database:

QXCR1000027125: Repmaint times out and so HDD gets filled out fast. Large Databases May See Repmaint.
exe Hang).

There is a potential problem with large databases and repmaint. This can occur in all reporter versions that
ship with OVIS A.04.50, A.05.00, A.05.20 and A.06.00. If the database is very large (millions of records,
more than 2GB in size), it is possible that repmaint stops truncating the OVIS data tables. The trace.repmaint
and status.reporter show an entry similar to:

IDLE TIME OUT after x Minutes; 'RepMaint.exe’

After that, repmaint may hang.

This seems to be a "known" reporter problem and documented in the reporter troubleshooting information.
However, if the data isn't truncated anymore, the database will grow and performance for all programs
accessing the database will degrade. In addition, it is not obvious that this is in fact a critical problem since
the status only says "Warning" instead of "Error".

Software Support Online Link: _http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000027125

Workaround 1 - Create Hang_Timer Registry Key. To workaround this issue, create the registry key;
HKEY_LOCAL_MACHINEASOFTWARE\Hewlett-Packard\The Reporter\CurrentVersion\Hang_Timer. The default is
3 (in minutes), try 50 (minutes) or larger.

Create the TrimRate registry value under \HKEY_LOCAL_MACHINE\SOFTWARE\Hewlett-Packard\The Reporter
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\CurrentVersion\TrimRate. This decides the number of delete statements to be run for a day.

For example, TrimRate=6 would run 4[24/6] delete statements to delete a days worth of data. Splitting delete
statements increases the speed of deletion.

Workaround 2 - Lower the Runtime Value for repmaint.exe in the Database.

One other possible solution is to lower the runtime value for repmaint (default is 800) in the database. This
will hopefully avoid the problem of repmaint hanging the system, since the scheduler will kill it much sooner
then the default and the theory is that it will kill it before it hangs, however in practice this is not always true.
Also if the scheduler kills it before it finishes then you will have more data (then as set in retain days) in the
dashboard and in the reports, since repmaint did not remove the data before it was killed.

Microsoft SQL Server 2000:

Method 1: Use the Enterprise Manger GUI for SQL and
. open the reporter database

. edit the scheduler table

. find the row for repmaint.exe

. change the runtime value to 60.

A WNBER

Method 2: You can use osql:

1. start a command prompt window

2. osgl -S.\OVOPS -Uopenview -Popenview

3. use reporter

4. go

5. update schedule set runtime=60 where program="Repmaint.exe’
6. go

Oracle:

Method 1: Use the Oracle DBA Studio and
. open the reporter database

. edit the scheduler table

. find the row for repmaint.exe

. change the runtime value to 60.

A WNBE

Method 2: You can use SQL Plus Worksheet:
1. connect to the reporter DB with the correct user/password
2. update schedule set runtime=60 where program="Repmaint.exe’

Note 1: that if you are not using the user openview with password openview you will need to change these to
what ever user/password you are using.

Note 2: If you upgrade OVIS or install full reporter then this value will revert back to the default of 800 and
you will have to change it again.

Note 3: This is not a supported thing to do, so be very careful

Some Other Things to Consider

1. If this is a very large Database (500,000 or more rows in the iops_detail_data table) you might want to
stop the OVIS and Reporter service and run repmaint by hand to let it catch up. This could run for several
days depending on how far behind it is.

2. You can find out how out many days repmaint it behind by running a sql query to find out the max and min
of the column datetime.

Select min(datetime), max(datetime) from iops_detail data;

Then looking at the value you have in retain days for the detail data (5 minute data).
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QXCR1000046402: Error messages in newdb when Oracle is DSN.

For example:

2003/01/13 10:19:41 (4):(1740) SQL Execute error; ORA-04080:

trigger '"CUSTOMER_MASTER_TRG' does not exist

2003/01/13 10:19:41 (4):(1740) Error -1; State:S1000,Native:4080,0rigin:
[Oracle][ODBC][Ora]

2003/01/13 10:19:45 (5):(1740) Error opening [DISCOVERDOMAINS]; ORA-

00904: invalid column name

2003/01/13 10:19:45 (5):(1740) Error -1; State:S0022,Native:904,0rigin:
[Oracle][ODBC][Ora]

2003/01/13 10:19:45 (5):(1740) Error opening [DISCOVERSYSTEMS]; ORA-

00904: invalid column name

2003/01/13 10:19:45 (5):(1740) Error -1; State:S0022,Native:904,0rigin:
[Oracle][ODBC][Ora]

Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000046402

Resolution: If you are installing OVIS with an Oracle database, you may see
a number of error messages in the trace files. You may ignore these messages.

QXCR1000047921: Oracle 9.2.0.1 Client breaks OVIS Dashboard & MeasEvent.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000047921

Workaround: On the Oracle 9.2 Client software you need to give the Authenticated User privilege to the
Oracle Home by following these steps:

=

Log on to Windows as a user with Administrator privileges.
2. Launch Windows Explorer from the Start Menu and navigate to the ORACLE_HOME directory.

3. Right-click on the ORACLE_HOME folder and choose the Properties option from the drop down list.
Properties window should appear.

4. Click on the Security tab on the Properties window.

5. Click on Authenticated Users item in the Name list (on Windows XP the Name list is called Group or

user names).

6. Uncheck the Read and Execute box in the Permissions list (on Windows XP the Permissions list is
called Permissions for Authenticated Users). This box will be under the Allow column.

7. Check the Read and Execute box. This is the box you just unchecked.
8. Click the Apply button.

9. Click the OK button.

10. Reboot your computer after these changes have been made. Re-execute the application and it should

now work.

QXCR1000050185: measevent fails to continue running after database connection restored. This will cause

"no probe info" conditions and alarms indicating that no data is being received from probe locations.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000050185
Workaround: Restart IIS.
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QXCR1000209660: If the DB is shutdown while OVIS is connected to it, OVIS will not try to
reconnect to it automatically.

Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000209660

Workaround: To force OVIS to reconnect to the DB run

IISRESET at a command line on the OVIS Measurement server. It will also be

necessary to close/reopen any OVIS Configuration Managers.

QXCR1000027125: Removal of old data in database fails with a timeout.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000027125
Workaround: Contact support since there are multiple possible causes and potential solutions to this problem.

No QXCR: Setting of DWORD TraceTableOverwriteCheck to 1 under HKEY_LOCAL_MACHINE\SOFTWARE
\Hewlett-Packard\Internet Services\CurrentVersion prevents measEvent from overwriting records in the trace
table that haven't been committed to the Reporter database yet when iopscollector is lagging behind.

Services:

QXCR1000220817: ovcd throws application error after reboot.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000220817
Resolution: Please contact HP Support for assistance.

QXCR1000228581: ovc fails to start on XP system with OVPM 4 and OVIS 6.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000228581
Resolution: Please contact HP Support for assistance.

OVPM Integration:

QXCR1000210865: OVPM Lite (HPGC) no longer gets Service Type list updated.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000210865
Resolution: Please contact HP Support for the latest update on this defect.

QXCR1000211412: OVPM does not detect changes in Restricted Views in OVIS

If there is a password for All Customers, even if restricted views is turned off you will get the following errors
when launching insight lite:

« Invalid password supplied for the admin customer (errl8)

= Invalid password supplied for the admin customer (errl8)

« No data source was specified. Please select a system or other data source (err203)

Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000211412

Workaround: OVPM 5.0 synchronizes passwords once a day. To workaround this either restart OVPM 5.0 or
wait for OVPM to automatically update.

QXCR1000227662: OVPM 5.0 Installer does not ask for Port when installed on top of OVIS 6.0.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
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docid=QXCR1000227662

QXCR1000230210: All Service Types are displayed in OVPM dashboard drop down menu when logged in as
a specific user.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000230210

If you turn on restricted views in OVIS and then synchronize the passwords in OVPM Admin, then bring up the
OVIS dashboard and log in as that user and then bring up custom graphs it correctly only lists that customer.
However, it lists all the service groups in the service type drop down. If you select a service type that does not
belong to that customer is gives an error that there are no metrics and it does not draw a graph.

If you have profiles set up, the same behavior is exhibited. You see all the service types, however you can
only draw a graph for the customer selected in the customer box. If you select any other service type, even if
one of the other customers in the profile has that service type, you will get the same error message and no
graph.

Resolution: Please contact HP Support for the latest update on this defect.

No QXCR: Installing OVPM 5.0 UNIX on top of the OVIS 6.0 remote probes may cause ovc not to start.
Workaround: Start ovc manually after the OVPM install.

OVTA Integration:

QXCR1000047323: You must restart 11S to enact any OVTA integration configuration change. This includes
disabling, enabling, or changing configuration parameters in the integration.

Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000047323

Workaround: Restart I1S to enact any OVTA integration configuration change.

No QXCR: The OVIS-OVTA integration has a requirement that system clocks be synced within 5 minutes. If
the OVTA and OVIS Management Server's system time differ by more than 5 minutes then the integration will
experience data loss.

OVO Integration:

QXCR1000044021: Cannot get OVIS alarms to appear in the OVO message browser.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000044021

Workaround: Upgrade OVO agent to latest 7.x version plus any applicable patches. If this is not possible
because the OVO Unix or OVO Windows console does not support that agent version, then you must install
both OVIS and the OVO agent on the C: drive due to an agent defect in the 7.0 version. This may involve

uninstallating all OpenView tools on this system and reinstalling them on the C: drive.

QXCR1000213992: Documentation does not describe the integration with clustered OVO/Win 7.5
Management Server. Installing OVIS and a clustered OVO/Window (7.5 or higher) on the same system is not
supported.

Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000213992

QXCR1000228246: Uninstalling XPL removes OvDataDir and OvlinstallDir env variables.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000228246
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Workaround: When the HP OpenView Cross Platform (XPL) component is uninstalled as part of another HP
OpenView application co-resident with OVIS 6.0, the XPL environment variables are removed. This causes an
error message to be displayed in the TIPs Viewer stating that the TIPs database cannot be accessed at the
location C:\Program Files\HP Openview, especially if the installation directory is at a non-default location. The
script to reset the environment variables is on the OVIS CD in \Support\Support Tools\SetOVEnvVars.vbs.
Double click the file to execute it or call it with cscript (no arguments) $ cscript SetOVEnvVars.vbs.

QXCR1000229220: upgrading of XPL to 2.60.030 and above on OVOW is not starting old trace service.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000229220

No QXCR: Whenever an OVO for Windows or UNIX agent is installed after OVIS, you must reboot in order to
ensure that alarm forwarding works correctly.

Dashboard:

QXCR1000218369: Launch OVTA Console button doesn't auto route for Mozilla
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000218369

Workaround: Install Java Web Start manually first, then when you select Launch OVTA
Console, the OVTA console will launch as expected.

QXCR1000229132: Custom Graphs not updating Customer list when deleting customer.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000229132
Workaround: After deleting a customer, the customer will be removed from the customer list in the Reports

workspace, but it will remain in the Custom Graphs workspace until the data for that customer has rolled out
of the database.

QXCR1000231923: Exception displayed after leaving browser idle for 2 or more hours with restricted views.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000231923

Workaround: If you have restricted views enabled, and you log into the dashboard and then leave the
browser idle for more than two hours in any workspace other than the Health workspace, and the next thing
you click on is the Reports or Custom Graphs workspace icon, you will get an exception in the results pane. To
resolve this, click on the Health workspace icon, which will redirect you to the login page.

No QXCR: If the application server running the OVIS Dashboard (Tomcat server) is hit repeatedly with unique
requests, such as those from the HTTP_TRANS probe, it may run out of memory and either abort or return out
of memory errors to browsers. Each unique session has resources associated with it and Tomcat will hold
these resources open for up to two hours after the last request has been made, even if it has already expired
the session.

Workaround: The memory can be increased by entering the following at the command line on the OVIS
Management Server:

<install dir=\nonOV\tomcat\a\bin>tomcat5w //ES//OvTomcata

Select the Java tab and then increase the Initial Memory Pool and the Maximum Memory Pool fields to 512 or
greater.

Web Transaction Recorder:
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QXCR1000045604: In the OVIS Web Transaction Recorder (HTTP_TRANS probe) IE Heavyweight mode, the
transaction may fail if the first step is an https target and if a proxy is configured which requires
authentication.

Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000045604

Resolution: If the transaction fails, install hot fix Q329802 from the Microsoft web page.

QXCR1000050110: Webrecorder loses the ability to record raw clicks and keys.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=0QXCR1000050110
Workaround: Exit and reenter the web recorder.

QXCR1000091102: Scripts with IMCLICK or 'KEY stmts may need re-recording.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000091102

QXCR1000221308: HTTP_TRANS "Test On Management Server" fails with application Error on W2K.

Running probehttptrans2 with the -print option will not produce results on windows 2000 because that
platform does not support the ability to write to a console from a windows gui application. This means that the
option to "Test on the management server” in the Configuration Manager will not return results.

Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000221308

No QXCR: If you encounter either of the following problems:

Popup boxes indicating that processes (particularly the probe processes or scheduler) are terminating
abnormally due to initialization errors, or Problems with Web Transaction Recorder transactions recorded in
Internet Explorer mode.

Workaround: All probes run under the "HP Internet Services" service, which by default is

configured to run as the System account. If you encounter these problems, reconfigure the HP Internet
Services "System Account" setting by selecting "This account:" and entering the account (user name) and
password that recorded the transaction. This applies to both the Management Server and remote probe
systems. This configuration information is accessed via the Computer Management > Services and
Applications > Services = Properties > Log On selection.

Probes:

QXCR1000026831: SAP probe shows no data instead of unavailability when it times out (UNIX only).
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000026831

QXCR1000027371: OVIS drill down query for SMS probe queries for SMS not SMS_PROBE
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000027371

Workaround: While the problem itself is resolved (in OVIS 5.20) there are two residual issues from the
problem that may need to be worked around:

1. If you were running the SMS probe before the upgrade to OVIS 6.0, and want to see your data in the
dashboard from the previous OVIS install, you need to run the following database query to fix the new SMS
probe name on the Reporter database:
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update IOPS_SERVICES set PROBENAME = '‘SMS_PROBE' where PROBENAME = 'SMS';

2. If you have a config.xml file that was saved prior to OVIS 5.20, you may need to change the probe name in
the XML file from "SMS" to "SMS_PROBE", in order for the xml file to load correctly in OVIS 6.0 and beyond.
For example, change from:

<SERVICE id="Test" probe="SMS">

to:

<SERVICE id="Test" probe="SMS_PROBE">

After changing the probe name, the old XML file should load without any problems.

QXCR1000046420: SAP probe produces *.trc files in probes directory.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=0QXCR1000046420
Workaround: Delete the trace files.

QXCR1000049829: httptrans probe IE mode may generate Temporary Internet Files that can fill up a disk
drive.

Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000049829

Workaround: See Microsoft URL http://support.microsoft.com/?kbid=301057 for a discussion of problem,
cause, and workaround.

Another option is to create a script probe to delete these files: Create a script that will delete the files out of
the Temporary Internet Files folder. Then use the script probe in OVIS to run this script once a day. Give this
probe a priority of 1 and all the other probes a priority of 2 so that when they do fire together once a day this
script probe will run first before any of the other probes, to avoid any collisions. This script should be placed in
the \newconfig\distrib\platform\windows directory so that it will only be distributed to windows boxes. Then
under the probe location for that probe add all the systems where you are experiencing this problem. Here is
an example of one script:

attrib -s " C:\Documents and Settings\Admin\Local Settings\Temporary Internet Files"

del /Q "_C:\Documents and Settings\Admin\Local Settings\Temporary Internet Files\*.*"

The first line in this script was required to remove the system attribute from this folder so the delete could
take place, this could be different on your system. The /Q option for delete is so that it will not prompt before
deleting the files. Also note this is the path to my Temporary Internet Files it could be different on your
system. You might also have folders under this directory that you want delete so you would need to change
this script for that as well. Also you could have file and/or folders under a different user that you want deleted,
so again you would have to modify this script for that.

Here is a second example of how one of our customers modified the above script to suit their environment:
rmdir /Q /S "C:\Documents and Settings\Default User\Local Settings\Temporary Internet Files\Content.IE5\"

QXCR1000050253: OVIS's IMAP probe is unable to delete messages when the message pile up is over
approx. 600 messages.

Software Support Online Link: _http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000050253

Workaround: Delete the mail pile up by either configuring a POP3 probe to the same mailbox or by logging in
with a mail interface and deleting them in that interface. Ensure that the IMAP probe is run frequently enough
along with the SMTP probe, to avoid such a pile up.

QXCR1000222464: OVIS probes don't work with Some HTTPS servers.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000222464
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QXCR1000223987: probelcmp requires the "ping" program in the root user path on Unix systems.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000223987

Workaround: The "ping" command path (“/usr/sbin”) must be in the

user’s path that starts the OpenView Control (OVC) service. By default, "root" is the user that
starts OVC. However, any user that has the privilege to start OVC, must have "ping" in their PATH
for probelcmp to work correctly.

QXCR1000230754: TFTP probe downloads target file(s) to <install dir> \bin directory.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000230754

No QXCR: If you get the following error message with the DNS probe TIP: Incorrectly built binary which
accesses errno or h_errno directly. Needs to be fixed.

Workaround: Do the following:

cd /opt/OV/bin

mv dig _dig

cp /usr/bin/dig .

The probe results are not impacted even with this error message.

QXCR1000231978: The Perfstat -v command may not work on some SuUSE Linux installations.

Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000231978

Workaround: The problem is because the system is missing the binutils package. Please install the binutils
package and then attempt to run the perfstat command.

No QXCR: When you deploy a new or changed custom probe (built with the SDK or Probe Builder) or have a
new or changed SRP file (for the script probe), you must restart Tomcat by running ovc -restart ovtomcatA
and exit the current Dashboard session.

Configuration:

QXCR1000050474: Concurrency issues when using SLO dialogs.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000050474

QXCR1000086794: Unable to run repair.vbs to fix Conf Mangr: it has problem initiating log file.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000086794

QXCR1000208785: Restricted View password cannot have a leading or a trailing Space.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000208785

QXCR1000211534: Missing alarm entry in the IOPS_ALARM_DATAZ2 table when a probe’'s URL changes
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000211534

QXCR1000218263: Same labels for Service Targets in the same Service Group causes confusion
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Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=0QXCR1000218263

QXCR1000228842: Restricted Views allowing customers to login with no password.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000228842

QXCR1000229174: Configuration Manager tree does not use labels when configured.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000229174

QXCR1000230213: ORA-01460 error when attempting delete in Configuration Manager.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000230213

QXCR1000230239: License Wizard when closed causes Configuration Manager to hang.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000230239

Workaround: If you click on the window 'X' button to close the window in the License, this can case the
Configuration Manager to hang. The license changes were saved. This problem will occur on systems with
Autopass 5 installed. To check if you have Autopass 5, inside of the License Wizard window click on the Help-
>About box. To work around the hang or abort of the Configuration Manager when closing the license wizard
window, close the License Window through File->Exit.

QXCR1000230240: OVIS License Wizard Button Does Nothing.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000230240

TIPs Server:

QXCR1000216825: Browser stop button doesn't stop TIPs execution.

Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000216825

Workaround: When selecting the browser’s stop button, it appears that TIPs continues to execute,but never
displays any results. In affect, the browser's stop botton action does not stop TIPs execution. In the TIPs
Server log file, the following exception occurs during this situation.

The TIPs Server cannot return the TIPs results. Cause: The TIPs Server cannot prepare the TIPs results for
presentation. Cause: ClientAbortException: java.net.SocketException: Connection reset by peer: socket write
error

You can either close the TIPs Viewer window and re-select TIPs or select the brower's refresh button to get the
TIPs Viewer to re-execute the TIPs.

QXCR1000219792: Expect scripts from Unix remote probe systems can result in a timeout error message.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000219792
Workaround: The following error message displays in the TIPs Viewer as part of an expect script result:

Error: Timed out attempting to connect to system <hostname=>
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The problem occurs when the HP OpenView Ctrl Service's environment has startup errors which impact the
ability for TIPs expect scripts to run successfully.

The remote probe system must be rebooted, to restart the HP OpenView Ctrl Service with sufficient
environment. To insure that the HP OpenView Ctrl Service starts correctly upon reboot, root's .profile file must
only contain commands that will execute correctly at boot time since HP OpenView Ctrl Service starts with
root's .profile configuration.

After rebooting the remote probe system, use the following command to insure that HP OpenView Ctrl Service
is running.

ovc -status

TIPs expect script commands should no longer timeout.

QXCR1000220603: OvTIPsServer.bat writes to incorrect log file.

Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000220603

Workaround: OvTIPsServer.bat writes to the log file OvCommonProcesses_0_0.log instead of
OvTIPsServer_0_0.log. When troubleshooting is necessary after running OvTIPsServer.bat, consult the
OvCommonProcesses_0_0.log file.

QXCR1000221982: Restarting Tomcat or doing a Save Configuration action results in Triggered by Alarm
thread death exceptions.

Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000221982

Workaround: This problem occurs while Triggered by Alarm execution is enabled and active, but the Tomcat
process was stopped or a Save Configuration was done in the TIPs Configuration program. As a result, in the
TIPs Server log file, the following exception is recorded.

The TIPs request command <commandName=> failed to execute on <host>. Cause: java.lang.ThreadDeath
java.lang.ThreadDeath

The alarm trigger execution for <TIP> cannot process. Cause: java.lang.ThreadDeath

Shutting down the TIPs Server.

The problem indicates that outstanding Triggered by Alarm executions could not complete at the time the TIPs
Server was stopped or re-started. This situation is harmless.

QXCR1000223693: TIPs database (JDO) is limited to approx 2 GIG of data.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000223693

Workaround: When the following error message is logged in the TIPs Server log file, the Triggered by Alarm
database has reached its maximum size.

Unknown internal JDO error encountered - attempting to rollback transaction
This problem can be encountered under the following conditions:

. The dataRetain parameter is set to the maximum value (2000 MB) or near maximum value.
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Large amounts of data are collected on an hourly basis.

The problem arises because the amount of data collected can extend beyond the configured maximum value
prior to the next Triggered by Alarm purge operation.

To prevent exceeding the amount of collected data, you should set the dataRetain parameter to a value such
that the amount of data collected on an hourly basis does not exceed the maximum value (2000 MB). Refer to
the Understanding Triggered by Alarm Parameters section in the TIPs online help for more information about
configuring Triggered by Alarm limits.

QXCR1000226130: TIPs cannot execute; TIPs Runner not found after IP address change.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000226130
Workaround: When this problem occurs, the following error displays in the TIPs Viewer:

The server IP address has changed from <IP Address 1> to <IP Address 2>. An administrator should run
OvTIPsServerResetlP.bat to fix the problem.

The script stops the Tomcat process and the local TIPs Runner; updates the registration records and
configuration files; then restarts the Tomcat process and the TIPs Runner. The new configuration is in place
when the processes are restarted.

QXCR1000226428: Java Out of Memory exceptions are not handled gracefully within the TIPs Server.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000226428

Workaround: This problem may occur when the TIPs Server handles many Commands with large amounts of
data (e.g., several Triggered by Alarm TIPs with Commands that retrieve 1MB plus files). When encountered,
the TIPs Viewer indicates an internal error has occurred and the TIPs Server log file lists Out of Memory
exceptions. In addition, database (JDO) rollback errors may be encountered within the log file. Refer to the
steps in the known problem QXCR1000226521 for steps to increase Tomcat's memory.

QXCR1000226488: Database (JDO) exceptions are listed within the TIPs Server log file.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000226488
Workaround: When database (JDO) exceptions occur, the TIPs Viewer has the following display behaviors:

. The error message 'An internal problem occurred for a TIPs request. Consult the TIPs Server log file'
displays when TIPs is selected.

Real-time command results are displayed instead of Triggered by Alarm results, indicating that Triggered
by Alarm results were never collected.

When these problems occur, database (JDO) exceptions are logged in the TIPs Server log file. Such exceptions
include JDOEOFEXxception, ClassCastException, and NullPointerException.

As stated in the first case above, these exceptions indicate that an internal error has occurred and access may
have been lost with the configuration database. In the second case above, access may have been lost with the
Triggered by Alarm database.

In either case, you need to restart the Tomcat process to correct the database access for the TIPs Server.
Restart the Tomcat process with the command: <install dir>\bin\ovc -restart ovtomcatA.
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QXCR1000226521: TIPs Server fails due to Out of Memory.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000226521

Workaround: This problem may occur when the TIPs Server handles many Commands with large amounts of
data (e.g., several Triggered by Alarm TIPs with Commands that retrieve 1MB plus files). When encountered,
the TIPs Viewer indicates an internal error has occurred and the TIPs Server log file lists Out of Memory
exceptions. Execute the following commands on the OVIS management server to increase the memory
allocation used by Tomcat.

1. ovc -stop ovtomcatA

2. <install_dir=/nonOV/tomcat/a/bin/tomcat5w.exe //ES//ovtomcatA

3. Click on the Java tab.

4. Increase the Maximum memory pool value. The default maximum memory pool size is 512 MB.
5. ovc -start ovtomcatA

You may need to decrease the number of TIPs you are attempting to run at once or the amount you are
executing via Triggered by Alarm.

QXCR1000227425: TIP Command with large file is not completely displayed in the TIPs Viewer.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000227425

Workaround: This problem occurs when a text file of size approximately 150K or larger is displayed within
the TIPs Viewer for a particular TIP Command. When the problem happens, the contents of the text file is
truncated and any other commands associated with this TIP are not displayed.

TIPs has been configured to avoid this problem in the following way. For text files greater than 100K, TIPs
displays only the last 100K, taking care to start the display at the beginning of a line. The limit, 100K by
default, is configurable via the maxTextFileDisplaySize attribute of the DisplayProperties tag in OvTIPsServer.
xml. When a text file is trimmed by TIPs, the following line is added to the beginning of the output:

[NOTE: Only the last N percent of this file is displayed.]

where N is the percentage of the file displayed.

You can adjust the configuration to display more of the text file, but realize that the more data displayed, the
more likely this problem occurs. To adjust the configuration, modify the maxTextFileDisplaySize attribute of
the DisplayProperties tag in OvTIPsServer.xml. Restart Tomcat so the new configuration takes affect.

QXCR1000228896: TIPs Server log contains a java.io.InterruptedlOException message.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000228896

Workaround: After stopping Tomcat or doing a Save Configuration within the TIPs Configuration program,
the following exception is recorded in the TIPs Server log file:

Shutting down the TIPs Server.
java.io.InterruptedlOException: HttpServer.acceptConnection() has been interrupted.
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Although an exception is logged, this situation is harmless.

QXCR1000229055: java.net.UnknownHostException occurs during TIPs Runner registration.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000229055
Workaround: If a remote probe system is specified only by a hostname and the hostname is not registered

with DNS, the TIPs Runner most likely fails to register. The following message is logged in the TIPs Server log
file.

Can not create configuration java.net.UnknownHostException: <host>

Later, another registration attempt is made for the TIPs Runner, using the IP address. This registration most
likely succeeds. A registration success message is logged in the TIPs Server log file.

Registered <host>

Although an exception is logged, this situation is harmless.

To avoid this problem, use fully qualify hostname names with a proper domain name for remote probe (i.e.
TIPs Runner) systems.

QXCR1000229084: OvTIPsServer.bat script, without arguments, results in an exception.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000229084
Workaround: When OvTIPsServer.bat is executed without any arguments, the following exception is logged.

Error while creating server java.lang.NoClassDefFoundError: com/hp/ov/sec/core/SecCoreException
Although an exception is logged, this situation is harmless.

QXCR1000232870: TIPs does not work after first installing OVPM 5 in a non-default directory and then
installing OVIS 6. You see the following TIPs error: The TIPs request cannot execute. Probable Cause: TIPs
configuration data cannot be accessed. Consult the TIPs Server log file.

Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000232870

Workaround: If you installed OVPM 5 in a non-default directory (a non-default directory is anything other
than C:\Program Files\HP OpenView) and then installed OVIS 6, then configured customers and launched the
Dashboard, and you find that TIPs will not work, you can do the following to resolve the problem:

1. <install dir=\bin\ovc -stop ovtomcatA

2. remove all the files from the non-default <data dir>\datafiles\tips\database directory, note do not remove
the database folder

3. copy all files from C:\Program Files\HP OpenView\data\datafiles\tips\database directory to

<data dir>\datafiles\tips\database directory

4. <install dir=\bin\ovc -start ovtomcatA

5. Launch TIPs from the Dashboard and it should now work.

TIPs Runner

QXCR1000226804: Windows Script Probe re-exec fails. TIPs Runner needs access to the Windows desktop.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000226804
Workaround: The Script probe re-execute may fail if the script being executed requires access to the

Page 32



http://www.openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000229055
http://www.openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000229055
http://www.openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000229084
http://www.openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000229084
http://www.openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000232870
http://www.openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000232870
http://www.openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000226804
http://www.openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000226804

Release Notes - OVIS 6.0

desktop. The HP OpenView Ctrl Service is configured to not have access to the desktop. Hence, the script,
when launched via the TIPs Runner, will not have the required access to the desktop. (The HP Internet
Services service is configured to have access to the desktop, thus the script will execute successfully under
the OVIS scheduler.)

If a TIP Command requires access to the desktop, the HP OpenView Ctrl Service configuration on the TIPs
Runner system needs to be modified, enabling it with desktop access. Granting HP OpenView Ctrl Service
desktop access is done through the following steps:

1. On the TIPs Runner system, open the Windows Services manager.
Select the HP OpenView Ctrl Service.

Select the properties for this service.

On the LogOn tab, make sure the Local System account item is selected.
Check the Allow service to interact with desktop option.

Apply the changes.

N o o~ N

Re-start the HP OpenView Ctrl Service to insure the change takes affect

The Script probe re-execution command should now execute successfully for TIPs.

QXCR1000228454: Probe Re-Execution TIP fails to honor Run As User setting.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000228454

Workaround: The Probe Re-Execute TIP fails to honor the Run As User setting for HTTP_TRANS heavyweight
and probe builder custom probes. This results in probe re-execution failures displayed in the TIPs Viewer.

No workaround is available for this scenario.

QXCR1000229073: Upgrading probes on Unix, TIPs Runner does not get configured.

Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000229073

Workaround: When updating the probe system with a OVIS 6.0 remote probes installation, the new TIPs
Runner doesn't get registered unless the user explicitly selects the option 10. Save and Exit within
ovisactivate. If the user selects "11. Exit" during ovisactivate (since they're not changing any settings for
upgrade), the user will have to rerun ovisactivate to insure that the TIPs Runner gets configured.

QXCR1000229104: Possible memory leak on HP-UX 11.11 for TIPs Runners.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000229104

Workaround: When this problem occurs, the TIPs Viewer displays Command timed out messages
consistently for an HP-UX TIPs Runner.

Under certain circumstances the TIPs Runner (ovtiprn) process experiences memory growth. Typically this
occurs when log files are configured to be collected by the TIPs Runner and then executed on HP-UX probe /
TIPs Runner systems. If virtual memory becomes exhausted, the TIPs Runner process may begin to
experience memory-not-available related problems.

If this problems occurs, restart the TIPs Runner on the remote probe system with the following command:
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<install_dir=/bin/ovc -restart ovtiprn

No QXCR: After installing certificates on the TIPsRunner system, the system returns errors when ovc
commands are issued.

Workaround: When requesting SSL certificates using ovcert on the TIPs Runner systems, make sure the time
is synchronized properly with the OVIS management system. If the clock on the TIPs Runner system is behind
that of the OVIS management system the certificate nstalled is invalid. Any subsequent use of ovc commands
returns an error until the clock on the TIPs Runner system is adjusted forward. For example, ovc -status
returns the following error after the certificate request has been granted on the OVIS server system.

(ctrlI-21) Communication error when executing 'Status’ method. (sec.core-113) SSL certificate verification
error (The presented peer certificate is not yet valid.).

You can check the dates a certificate is valid for by using the ovcert -certinfo id command.

Resetting the clock on the TIPs Runner system to match that of the OVIS management system solves this
problem and allows ovc commands to complete normally.

No QXCR: TIPs Runner behavior when the TIPs Server is stopped or momentarily restarted.

Workaround: The following messages in the TIPs Runner log file indicate that the TIPs Runner tried to
communicate with the TIPs Server, but the TIPs Server did not respond. This problem occurs when the TIPs
Server is shutdown by the Tomcat process or when configuration is saved within the TIPs Configuration
program.

Sender for <host> <IP Address> failed 1 times: (xpl-0) connect() to '<host>:<IP Address>" failed. (WIN-0)
The operation completed successfully.

Error in getting response (xpl-118) recv() on '<IP Address>:<port>' failed. (WIN-10054) An existing
connection was forcibly closed by the remote host.

Insure that the TIPs Server has completely started after restarting the Tomcat process or after Save
Configuration within the TIPs Configuration program. Otherwise, these messages may be ignored.

No QXCR: TIPs Runner behavior when it cannot register with the TIPs Server.

Workaround: If the TIPs Runner can’t register with the TIPs Server during startup you will get the following
message in the TIPs Runner log file. The TIPs Runner will continue to attempt to register with the TIPs Server
until it is successful. Normally the TIPs Server is running before the TIPs Runner starts. However, if the
Tomcat process was just started, the TIPs Server may not yet be ready to receive requests by the time the
TIPs Runner is started. In this situation, you will see this message until the TIPs Server process comes fully
online.

Registration Manager failed 1 times: Did not get registration reponse from http://<host>:<port>/tips

Insure that the TIPs Server has completely started to avoid this situation. Otherwise, this message may be
ignored.

TIPs Viewer

QXCR1000226457: TIPs Viewer displays connection refused error.
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Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=0QXCR1000226457

Workaround: This problem may occur if many TIPs Viewer windows are launched and then terminated in an
abnormal fashion. Note: Manually closing TIPs Viewer windows does not produce this problem.

For example, if the TIPs Viewer windows are terminated ungracefully from the Task Manager, the browser
connections are not closed completely. This leaves the Tomcat process in a state where the maximum
communication (socket) limit has been reached. In this case, subsequent TIPs Viewer windows display a
connection refused error message.

To determine if the Tomcat process has reached it's communication (socket) limit, issue the following
command:

netstat -a

If many connections are listed in a CLOSE_WAIT state, then it suggests that Tomcat's communication (socket)
limit has been reached. Restarting the Tomcat process cleans out the CLOSE_WAIT states for outstanding
connections. Restart the Tomcat process with the following command:

<install dir>\bin\ovc -restart ovtomcatA

No QXCR: TIPs Viewer behavior with restricted views.
Workaround: When setting restricted views, the change takes place immediately and the Tomcat process
does not need to be restarted for the TIPs Viewer to realize the restricted views settings.

However, if one already has an active browser session with the OVIS dashboard and then the restricted view
configuration changes, the OVIS dashboard will not ask you to login again. In this situation, if TIPs is
executed, the security measures in place will not allow access to the TIPs Viewer until you login again with the
OVIS dashboard and reset your session.

TIPs Configuration program

QXCR1000220269: TIPs Configuration program fails at startup when there is no TIPs database.

Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000220269

Workaround: When this problem occurs, an exception is displayed, stating that the tipsUser could not login
to the database. You need to verify the state of the TIPs database. The TIPs database may be zero length or
may be corrupted.

Refer to the TIPs online help to restore the TIPs database. You will need to access the TIPs online help
directly, with the following URL, http://127.0.0.1:8080/0vTIPsHelp/help/config, since the online help can't be
access from the TIPs Configuration program in this scenario.

Note: The Tomcat process must be running to access the TIPs online help. To be able to restore the TIPs
database, the OvTIPs web application must be stopped.You will need to use the Tomcat manager application
to stop the OvTIPs web application in this case.

QXCR1000229620: Save Configuration always reports a failure in an internationalized environment (e.g.,
ja).
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
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docid=QXCR1000229620

Workaround: This problem is a case of improperly handling localized message content and hence always
reporting a failure. This problem does not interfer with the Save Configuration action of restarting the TIPs
Server. To workaround the problem, you have the following options:

. Continue to use the TIPs Configuration program as-is and ignore the error dialog. Instead rely on the
content of the TIPs Server log file as an indicator for success or failure (i.e., check to see if the TIPs
Server restarted properly).

. Use the Tomcat manager for restarting the TIPs web application (OvTIPs) after configuration changes. Use
the http://localhost:<port>/manager/html url to access the Tomcat manager functionality. (Note: Save
Configuration uses this approach to restart the TIPs Server after configuration changes).

. Set the system to use English message catalogs as opposed to your native language. This ensures that
the Save Configuration action is handled properly.

No QXCR: TIP help topic IDs cannot be specified with multibyte characters.

Workaround: When online help is selected from the TIPs Viewer for a particular TIP, a URL is launched,
specifying the particular TIP help topic ID. URLs do not support multibyte data. Hence for any TIP help topic
that the user wishes to create, they will need to limit the help topic ID to the standard ascii/English characters
(i.e., use the chars a-z, A-Z, and 0-9).

TIPs Authentication Data Manager

QXCR1000215215: Authentication Data Manager: Resize of the browser window occasionally requires a
manual refresh to update the table headers.

Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000215215

Workaround: This problem may be encountered with either Microsoft Internet Explorer or Mozilla browsers.
When the browser is resized, on occasion the corresponding table headers are not properly resized. To correct
the problem, simply use the refresh button on your browser, after resizing. This is simply a cosmetic problem.
It does not interfere with the operation of the Authentication Data Manager.

QXCR1000215223: Authentication Data Manager: Manually unselecting all items in the main viewer table
does not result in the global selector being un-selected.

Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000215223

Workaround: This problem exists with both Microsoft Internet Explorer and Mozilla browsers. It occurs when
you have used the global selector to select all of the items in the main viewer table, and then later individually
unselected all of the rows. You can either ignore it, or via the global selector, select all and then un-select all
to correct the problem. This is simply a cosmetic problem. It does not interfere with the operation of the
Authentication Data Manager.

TIPs provided by HP

QXCR1000229895: TIPs Outcome Rules for Failure Return codes are incorrect.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000215223

Workaround: The following Outcome Rules are configured incorrectly for a failure return code situation.
These outcome rules should be testing for the return code to be not equal to 0. The operator specified for the
return code is not set at all. In most of these cases, the failure outcome rule is testing for the existence of a
standard error message. This test does catch many failure situations for the associated commands.
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Return Code Failure for Target Routing Table for Unix
Return Code Failure for Target TCP Connections for Unix
Return Code Failure for Probe Execute

Return Code Failure for Probe TCP Connections for Windows
Return Code Failure for Probe TCP Connections for Solaris
Return Code Failure for Probe TCP Connections for Linux
Return Code Failure for Probe TCP Connections for HP-UX
Return Code Failure for Probe ARP Cache for Windows
Return Code Failure for Probe ARP Cache for Solaris

Return Code Failure for Probe ARP Cache for Linux

Return Code Failure for Probe ARP Cache for HP-UX

Return Code Failure for Probe TCP IP Statistics for Windows
Return Code Failure for Probe TCP IP Statistics for Solaris
Return Code Failure for Probe TCP IP Statistics for Linux
Return Code Failure for Probe TCP IP Statistics for HP-UX
Return Code Failure for Target Interface Statistics for Unix
Return Code Failure for Probe Interface Statistics for Windows
Return Code Failure for Probe Interface Statistics for Solaris
Return Code Failure for Probe Interface Statistics for Linux
Return Code Failure for Probe Interface Statistics for HP-UX
Return Code Failure for Probe Routing Table for Windows
Return Code Failure for Probe Routing Table for Solaris
Return Code Failure for Probe Routing Table for Linux
Return Code Failure for Probe Routing Table for HP-UX
Return Code Failure for Probe IP Configuration for Windows
Return Code Failure for Probe IP Configuration for Solaris
Return Code Failure for Probe IP Configuration for Linux
Return Code Failure for Probe IP Configuration for HP-UX
Return Code Failure for Nslookup for Windows

QXCR1000229912: More outcome rules are needed to test for probe re-execute availability.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000229912

Workaround: The Probe Execute command has many outcome rules configured to test whether the probe
result is available or not. If the probe is not available (e.g. equals 0), a critical outcome is displayed.

The following probe results indicate probe availability in a format that is not configured with the current Probe
Execute command outcome rules. When the following probe types are unavailable, the Probe Execute
command displays incorrectly a Normal outcome rule.

SYS BASIC WM : <host>: [SYS Basic WM ]
Avail ability =0
Protocol (http) Port (80) Ul (<host>) File (<URL>) Proxy (<host>:38088)
Avail ability =0
Probe SMS: [Host: Unspecified]: [SMg]
Availability = 0
Probe SCRIPT: [Custoner: Script]
Availability = 0

QXCR1000229917: Probe Execute command outcome rules don't work for STREAM_MEDIA probe types.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000229917
Workaround: The STREAM_MEDIA probe returns a non-standard return code. The Probe Execute command is
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configured with an outcome rule for a successful return code that equals 0. The STREAM_MEDIA probe returns
1 to indicate success. When the Probe Execute command is used to troubleshoot a STREAM_MEDIA probe, the
outcome rule is incorrectly displayed based upon the delivered outcome rules for this Probe Execute
command.

To correct the outcome rule for the STREAM_MEDIA probe, a different Probe Execute command needs to be
configured with an outcome rule for success where the return code equals 1.

Note: The existing Probe Execute command can not have an additional outcome rule added to it because the
required logic to is not supported.

No QXCR: TIPs is not available for OVTA probe types.
Workaround: OVIS OVTA probe types don't provide sufficient information for TIPs execution. Within the OVIS
Dashboard, you will not see a TIPs icon associated with OVTA probe type probe locations.

QXCR1000230473: Exchange commands work only if Profile is set to Exchange server hostname.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000230473
Workaround: There are three out-of-the-box TIP command categories specific to Exchange probes:

. Exchange Directory Service
. Exchange Information Store

Exchange System Attendant

These are not enabled out of the box. However, if the TIPs administrator enables them (adds them to a TIP
that is enabled), the commands will work *only* if the OVIS exchange service target is configured with a mail
profile name that is the exchange server's hostname. If the configured profile name is not set to the
hostname, the TIPs viewer will display the following error:

[SC] OpenSCManager FAILED 1722:

The RPC server is unavailable.

QXCR1000230380: The 'Probe Re-Execute’ TIP Outcome Rules ignore the query results for DNS Probe re-
execution. Instead, the outcome response is soley based on the availability of the DNS Server.

Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000230380

Workaround: The current '‘Probe Re-Execute’ TIP relies upon a single 'OVIS Service Probe' command to re-
run probes, where outcome processing is limited to examining the 'Availability’ string. An additional command
will need to be added for handling the special case of the DNS probe (see note below for the reason). To add
the required command, launch the TIPs Configuration GUI and proceed as follows:

1. Open the 'Probe Execute’ Command Category
2. Edit the 'OVIS Service Probe' command as follows:
1. Create a new condition with the attributes set as follows:

Name = 'DNS Service Type - Exclude’
Description = "Excludes execution against the DNS probe targets"
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Object Type = "ServiceTarget"

Object Attribute = "Monitored Service"
Operator = "Does not equal”

Value = "DNS

b. Save the new condition and command

3. Next create a new command in the '‘Probe Execute' category as follows:

Name = "OVIS DNS Probe"

Command = "$OV_VAR[ServiceTarget.Probe Command]"
Arguments = "$OV_VAR[ServiceTarget.Probe Arguments]"
Timeout = "60"

Add the pre-existing Command Condition "DNS Service Type only"
Create the following Outcome Rules:
"DNS Query Succeeded”

Name = "DNS Query Succeeded"
Outcome = "Normal*

Return Code = "not set"

Output Length = "not set”

Error Length = "not set"

Output Contains = "Answer found=1"
Error Output Contains -- leave empty

"DNS Query Failure"

Name = "DNS Query Failure™
Outcome = "Critical"

Return Code = "not set"

Output Length = "not set"

Error Length = "not set"

Output Contains = "Answer found=0"
Error Output Contains -- leave empty

4. Save the new Command and Command contents along with the Command Category

5. Perform a 'Save Configuration’

Note: The order in which outcome rules are processed is not predictable and may vary from one command
execution to the next. Therefore, this problem cannot be solved by simply adding an ‘Answer found=0*
Outcome Rule to the existing OVIS Service Probe command.

TIPs Documentation

QXCR1000228679: The TIPs online help does not print in its entirety.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000228679
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Workaround: When printing the TIPs online help from within the TIPs Configuration program or from within
the TIPs Viewer Oracle help system, images do not print. In some cases there are incorrect spacing issues
around characters.The printed online help content is readable, just not presentable.

QXCR1000229149: Online help for Authentication troubleshooting needs enhancement.

Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000229149

Workaround: The Authentication troubleshooting section in the TIPs Results Troubleshooting chapter of the
TIPs online help does not list the following error message. This error message should be included in this help
section for Scenario #1.

Node - myserver.hp.com ERROR: Code = 0x80070005 Description = Access is denied. Facility = Win32

In addition, the Probable Solution for Scenario #1 needs to mention adding the /user and /password
parameters to the WMIC command. This information is found in the WMIC Command Considerations section
under the Give TIPs Runner WMIC Privileges heading.

It should be noted that in Scenario #1, the first error message occurs for Unix target systems executing
Expect script commands. The second error message as well as this third error message occurs for Windows
target systems executing WMIC script commands.

QXCR1000229153: Need online help troubleshooting scenario for Target TCP Connections (netsh).
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000229153

Workaround: The TIPs Results Troubleshooting chapter of the TIPs online help does not list the following
error message. This error message should be included in this chapter with an associated Scenario and
Solution.

WARNING: Could not obtain host information from machine: [<host>]. Some commands may not be
available. Access is denied.

The Routing and Remote Access Service is not currently running on <host>. Please use 'net start
remoteaccess' on the machine to start the service.

This error message is the result of the TIPs Runner not having the right permissions configured for remote
execution of the netsh command.

If one reconfigures the HP OpenView Ctrl Service to log on as an administrator, instead of the system account,
and the TIPs Runner and target systems are in the same domain, the command works fine.

QXCR1000229655: Need online troubleshooting for HTTP probe with port appended to hostname.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000229655

Workaround: The following information needs to be added to the TIPs online help as a section within the
TIPs Results Troubleshooting chapter.

When TIPs is launched for an HTTP probe target and all of the Target Network Status commands fail, you
notice the commands are trying to operate on a hostname of the form <host>:<port>. For example, the
Target Nslookup command fails with the error "can't find myserver.mycompany.com:9080: Non-existent
domain".
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This problem can occur if the OVIS administrator has entered the web server port number in the host field
while configuring the HTTP probe target. TIPs will execute correctly if the administrator modifies the OVIS
target configuration so the port number is in the port field, and only the host portion of the URL is in the host
field.

QXCR1000229662: Online help needs a troubleshooting section for stale service targets.

Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000229662

Workaround: The following information needs to be added to the TIPs online help troubleshooting section for
the TIPs Results Troubleshooting chapter.

When TIPs Viewer displays a message such as the following:

The TIPs request cannot execute. Probable Cause: The TIPs request failed for ServiceTarget <number>. Failed
to find Service Target id '<number>" in the OVIS Database. Consult the TIPs Server log file.

This problem indicates that a "stale" service target entry exists within the OVIS dashboard. A stale entry is
one that has been removed from the OVIS configuration or re-configured under a different customer and/or
service group, but still appears in the dashboard. In time, the service target will disappear from the
dashboard. You can reduce the likelihood of seeing stale targets by reducing the dashboard's Time Filter.

QXCR1000229897: Need online help troubleshooting scenario for WMIC Commands against Windows 2000
service targets.

Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000229897

Workaround: The WMIC Commands troubleshooting section in the TIPs Results Troubleshooting chapter of
the TIPs online help does not list the following error message. This error message should be included in this
help section as another scenario.

Node - myserver.hp.com ERROR: Code = 0x80041017 Description = Invalid query Facility = WMI

This scenario indicates that a WMIC command is executed against a Windows 2000 service target. Windows
2000 systems don't support WMIC.

QXCR1000229910: Online help for Adding Authentication Records needs enhancement.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000229910

Workaround: The Adding Authentication Records section in the Using the Authentication Data Manager
chapter of the TIPs online help needs to emphasis that when adding a user name for a Windows system that
the user name should include a reference to the domain. For example, domain\user would be the syntax to
specify in the Username field for authentication for user within domain.

No QXCR: The Trigger By Alarm dataRetain maximum value is incorrect in the TIPs online help.
Workaround: In the TIPs online help, Understanding Triggered by Alarm Parameters section, the description
for dataRetain is incorrect. The maximum value is documented as 2095 MB. The correct maximum value is
approximately 2000 MB.

QXCR1000230130: Need to add online troubleshooting for telnet errors.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?

docid=QXCR1000230130
Workaround: The provided TIPs Expect commands, which use telnet to access a service target, assume a
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particular behavior for login prompts.

. The TIPs Runner is a Unix system.

o If the service target is a Windows system without telnet enabled, the following error message
displays for the Command result:

Error: Unknown domain for system <host>

o If the service target is a Windows system with telnet enabled, the following error message displays
for the Command result:

send: spawn id exp8 not open while executing "send "uname\r"" (procedure
"setCommandBasedUponOS" line 5) invoked from within "setCommandBasedUponOS *

. The Unix service target issues a particular syntax for login as well as for password. The login prompt is
required and evaluated first. A service target that only issues a password prompt will fail.In the case
where a Unix service target fails the telnet login, the following error message displays for the Command
result:

Error: Cannot connect to system <host>

In your environment, if you enable the Expect TIPs commands for your Unix service targets, and their
prompting behavior is different than the provided Expect scripts assume, you must modify the provided
Expect scripts to work in your environment.

In your environment, if you have Windows service targets, you must use the WMIC TIPs commands for
successful command results.

QXCR1000230728: Need online help troubleshooting information for Exchange command categories.
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000230728

Workaround: The TIPs Results Troubleshooting chapter of the TIPs online help does not list the following
error message for the HP-provided Exchange command categories.

[SC] OpenSCManager FAILED 5:
Access is denied.
There are three out-of-the-box TIP command categories specific to Exchange probes:

. Exchange Directory Service
. Exchange Information Store

. Exchange System Attendant

These command categories use the SC.EXE command to retrieve information about Microsoft Exchange
services. The above error is the result of the TIPs Runner not having the right permissions for remote
execution of SC.EXE. The TIPs Runner is launched by the HP OpenView Ctrl Service. The Ctrl service is
configured by default to log on under the local System account, which does not have the necessary
permissions for remote SC.EXE execution. To fix this problem, reconfigure the probe system's HP OpenView
Ctrl Service to log on under an account with remote access privileges. For many network environments, this is
an Administrator account.
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Custom Probes SDK:

QXCR1000047817: In the Custom Probes SDK the command line switch must be prefixed by a "-". You can
not use a "/". This was implemented as an enhancement to allow a file name which might include a leading "/*
to be used as a parameter in the script probe and others. This is a common requirement for scripts run on
Unix systems.

Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=0QXCR1000047817

Workaround: Use "-" instead of "/" for a command line switch.

NNM Integration:

There are several known minor issues with the OVIS/NNM integration package, most with simple
workarounds.

Problem: ODBC Roll Forward/Backward Errors

Cause: Occasionally, stopping the NNM services (ovstop) while ovw is running can later cause the database to
fail to start with error messages stating that "Roll Forward" or "Roll Backward" operations failed. This problem
has only been seen so far on Windows NT. The problem is a corrupt database log file. This problem has been
improved with the new Solid Server (3.51) shipped with NNM 6.2, however the problem has still been
observed only at lesser frequency.

Workaround: Run the command: $OV_BIN/ovisdb.ovpl -cl -restart

The database should then be running normally, without loss of data.

Problem: ODBC Cannot Find Source "tcpip 2691"

Cause: Occasionally, the database does not shutdown properly. This is also believed to be related to running
ovw sessions when ovstop is issued.

Workaround: Run the command: $OV_BIN/ovisdb.ovpl -restart to properly shutdown and restart the
database, without loss of data.

Problem: Symbol Display

Cause: There are a few scenarios where commands are stored to the command database, but are not
performed on an open map. This happens, for example, if the persistence level is not set to "All Levels" (see
the Internet Services User's Reference Guide), or if the node is not managed by NNM. The NNM menu choice
>Internet Services—=> Rebuild Internet Services Symbols causes NNM to delete all symbols that have
the "ovislsOVIS" field set TRUE, and then reperforms all commands in the command database. This ensures
that the map reflects what is currently in the database.

Workaround: There are mechanisms built into the integration package to recover missed configuration
changes and alarms. However, if you suspect that NNM is not synchronized with OVIS, the script $OV_BIN/
ovisclean.ovpl completely clears the command database and causes NNM to pull all of the latest configuration
and alarm data. The script also rebuilds all symbols. Before running ovisclean.ovpl, make sure to shut down
any running OVW sessions.

Problem: Multiple Service Groups of the Same Type do not display correctly.

Cause: Because service symbols are created by type (HTTP, DNS, FTP, etc.) no distinction is made between
service groups of the same type for a given target node. In other words, if you configure two service groups,
such as SG1 and SG2, that are both HTTP service groups, and both service groups contain the target node foo.
com, you can see that on the NNM map the node symbol for foo.com contains only one HTTP service symbol.
All alarm symbols for both SG1 and SG2 are created under this one HTTP service symbol. More importantly, if
you later delete one of these service groups, the NNM integration package responds as though the entire HTTP
service is being deleted, and removes the HTTP symbol under foo.com.
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Workaround: Run the ovisclean.ovpl script to restore the remaining service group.

Problem: Changing Customer Name in OVIS is not automatically updated by NNM. As a result, events
targeted to that customer are logged as errors, and the symbol reflecting the customer's old name is not
updated.

Workaround: Run the ovisclean.ovpl script to force the NNM integration to re-establish the customer under
the new name.

Problem: Inconsistent Customer Views Status Propagation between NNM and OVIS.

Cause: In cases where Customer Views is installed on the NNM node that is integrated with OVIS, there is
inaccurate status propagation to customer symbols displayed in Customer Views symbols. For any OVIS target
node that serves more than one customer, the status propagation to the node reflects the status of all the
customers served by the node. However, if a customer symbol in Customer Views has that node beneath it on
the hierarchy (for example, in the "Servers" container), the status of the customer symbol reflects the status
of all customers served by that node. This is due to the fact that OVIS integration creates a child symbol for
each customer served by a given node, and thus the node's status is determined by the status of all its
customers. Because the customer symbol in Customer Views obtains its status from the node, the status for a
given Customer Views customer symbol becomes a function of all customers served by the node. The problem
arises from inconsistent modeling of customer, service, and targets between NNM and OVIS.

Workaround: At this time there is no fix or workaround for this problem.

Verified Environments

Supported Platforms

OVIS Management Server is supported on the following platforms:

. Windows 2000 Professional/Server/Advanced with Service Pack 4

. Windows 2000 Datacenter Server is supported, however advanced features of Datacenter Server
such as cluster/failover are not supported

. Windows XP Professional with at least Service Pack 1

. Windows Server 2003 Standard and Enterprise editions
OVIS Windows probes are supported on the following platforms:

. Windows 2000 Professional/Server/Advanced with Service Pack 4
. Windows XP Professional with Service Pack 1

. Windows Server 2003 Standard and Enterprise editions
OVIS UNIX probes are supported on the following platforms:

. HP-UX 11.0, 11.11, 11.22 and 11.23 (runs on Itanium in PA-RISC emulation mode)
Page 44



Release Notes - OVIS 6.0

. Solaris 2.8, Solaris 9
. Linux Red Hat 8.0, 9.0 and ES 2.1, ES 3.0

SUSE Linux Enterprise Server 8 & Professional 8.1 (32 bit)

The following Operating System patches and components are required:

Platform Patches

PHSS 24627 HP aC++ -AA runtime libraries (aCC A.03.33)
PHSS 24303 Id(1) and linker tools cumulative patch
PHCO_25707 libc cumulative patch

PHCO_26000 Pthread library cumulative patch

PHSS 30967

ksh

For Solaris 7:

106327-15 SunOS 5.7: 32-Bit Shared library patch for C++
106950-18 SunOS 5.7: Linker Patch

106980-23 libthread patch

HP-UX 11.0,11.11

Solaris For Solaris 8:

108434-08 SunOS 5.8: 32-Bit Shared library patch for C++
108993-25 LDAP2 client, libc, libthread, libnsl libraries
109147-15 SunOS 5.8: Linker catch

110934

ksh

ksh
RedHat Linux requires compat-libstdc++7.3-2.96 or higher

Linux

Note that the following probes are not available on UNIX: Streaming Media, SMS, SYS_BASIC_WMI, ODBC,
Exchange, and OVTA integration service types - WEBAPP, SOAPAPP, JMSAPP, RMIAPP, COMAPP. HTTP_TRANS
probe in Internet Explorer heavyweight mode is not available on UNIX but is available in URL mode on UNIX
systems. NTLM authentication is not available on UNIX in the HTTP, HTTPS, SOAP and HTTP_TRANS URL mode
probes but the other authentication modes are supported. The Dial probe is available on windows and all UNIX
platforms except SUSE Linux.

Databases - The following databases are supported:
Microsoft SQL Server 2000 Desktop Engine Service Pack 3 or 3A running on Windows 2000 Service Pack

4, Windows XP Professional Service Pack 1, or Windows Server 2003

. Microsoft SQL Server 2000 Service Pack 3 or 3A running on Windows 2000 Service Pack 4 or Windows
Server 2003 (In addition, the client software is supported on Windows XP Professional Service Pack 1)

. Oracle 8.1.7 running on HP-UX 11.0 (32-bit) or Solaris 2.7, 2.8

. Oracle 9.2.0 running on HP-UX 11.0 (64-bit), 11.11 or Solaris 2.7, 8, 9 (32-bit and 64-bit)
Internet browsers - The following browsers are supported for the OVIS Dashboard:

Microsoft Internet Explorer 6.0 with Security Update and the latest service pack
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. Mozilla 1.7.2 (HP-UX Mozilla is version 1.6)

Reporting - OVIS reporting component uses Crystal Reports 10

See the section below and check the OpenView web site for current information on compatibility of OVIS with
new releases of OVO, NNM and other OpenView products.

Integration with Other OpenView Solutions

OVIS integrates with the following OpenView products and versions:

hp OpenView Reporter A.03.60
. hp OpenView Performance Insight 5.0
. hp OpenView Service Information Portal 3.2
. hp OpenView Performance Manager OVPM A.04.04 patch CD, C.05.05, and C.05.00
hp OpenView Performance Agent 3.x/ARM and 4.0/ARM
hp OpenView Operations for Unix version 7.1 (HP-UX and Solaris) and 8.1 (HP-UX and Solaris)
hp OpenView Operations for Windows version 7.21 and 7.5

. hp OpenView Network Node Manager 7.0 Windows 2000, HP-UX and Solaris; NNM 7.01 Windows 2000,
HP-UX and Solaris; NNM 7.5 Windows 2000, HP-UX and Solaris

hp OpenView Transaction Analyzer 2.1, 3.0

hp OpenView Business Process Insight OVBPI 1.1
OVIS integrates with hp Systems Insight Manager SIM 4.2 (Note Traps are not 118N)
OVIS integrates with OVIS Probe Builder 2.0, 2.1

Note: The OVOW integration for OVIS 6 requires OVOW agent version 7.27 or higher on the OVIS
management server (patch OVOW_00059).

Note: The latest NNM patch must be installed when OVIS and NNM 7.5 are installed on the same system.
Otherwise, there will be conflicts during uninstall of OVIS. In more detail: OVIS will remove ovsnmp.dll and ov.
dll during its uninstall which will break NNM. The latest NNM patch will prevent this. The patch can be installed
after NNM 7.5 and OVIS 6 have been installed on the same system.

Make sure to not use terminal services when installing the NNM integration on Windows.

Check the OpenView web site (http://www.managementsoftware.hp.com) for current information on
compatibility of OVIS with new releases of other OpenView products.
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Integration with OpenView Components

OVIS includes the following embedded components:

Reporting component version A.03.60 (supports Crystal Reports 10.0)

. Graphing component version A.04.04

Refer to the Support folder on the OVIS CD for a list of installed files.

Local Language Support

OVIS is available in English and Japanese languages. Please check with your Sales Representative or HP
Partner for availability of the OVIS 6.0 Japanese release.

|Product Number - English |Product Name

|T3953AA |OVIS 6.0 Media - English

|T3954AA |OVIS 6.0 Manuals - English

|T3955AA |LTU - Base license, includes 5 standard targets - English
|T3956AA |LTU - Additional 5 standard targets - English

|T3957AA |LTU - Additional 25 standard targets - English

|T3958AA |LTU - Additional 250 standard targets - English
|J4530AA |LTU - Additional 5 custom targets - English*

|J4531AA |LTU - Additional 25 custom targets - English*

|J4532AA |LTU - Additional 250 custom targets - English*

* Note that Custom targets are only available with the English version.

|Product Number - Japanese |Product Name

1J4510BJ |OVIS 5.0 media - Japanese

1J4511BJ |OVIS 5.0 Manual - Japanese

| |

|J4512AJ |LTU - Base License, Including 5 pack - Japanese
|J4513AJ |LTU - Additional 5 pack - Japanese

|J4515AJ |LTU - Additional 25 pack - Japanese

|J4516AJ |LTU - Additional 250 pack - Japanese
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To activate the measurement server and manage Internet Services, you need to purchase

a Base license (LTU), product number T3955AA (English) or J4512AJ (Japanese), which

includes your first five (5) standard targets. If you require more than five targets, you

can purchase one or more add-on packs. Licensing is enforced on the total licensed capacity for OVIS probes
and total licensed capacity for custom probes.

Support

Please visit the HP OpenView web site at: http://www.managementsoftware.hp.com/ This web site provides
contact information and details about the products, services, and support that HP OpenView offers.

You can also go directly to the support web site at:

http://support.openview.hp.com/

HP OpenView online software support provides customer self-solve capabilities. It provides a fast and efficient
way to access interactive technical support tools needed to manage your business. As a valuable support
customer, you can benefit by being able to:

. Search for knowledge documents of interest
. Submit and track progress on support cases
. Manage a support contract
. Look up HP support contacts
. Review information about available services
. Enter discussions with other software customers
. Research and register for software training
NOTE: Most of the support areas require that you register as an HP Passport user and log in. Many also

require an active support contract. To find more information about support access levels, go to the following
URL:

http://support.openview.hp.com/access level.jsp

To register for an HP Passport ID, go to the following URL:

https://passport2.hp.com/hpp/newuser.do

To view release notes and other documentation go to the following URL:

http://ovweb.external.hp.com/lpe/doc serv/
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NOTE: To view files in PDF format (*.pdf), Adobe Acrobat Reader must be installed on your system. To
download Adobe Acrobat Reader, go to the following URL:

http://www.adobe.com

Legal Notices

Hewlett-Packard makes no warranty of any kind with regard to this manual, including, but not limited to, the
implied warranties of merchantability and fitness for a particular purpose. Hewlett-Packard shall not be held
liable for errors contained herein or direct, indirect, special, incidental or consequential damages in connection
with the furnishing, performance, or use of this material.

A copy of the specific warranty terms applicable to your Hewlett-Packard product can be obtained from your
local Sales and Service Office.

Restricted Rights Legend

Use, duplication, or disclosure by the U.S. Government is subject to restrictions as set forth in subparagraph
(c)()(ii) of the Rights in Technical Data and Computer Software clause in DFARS 252.227-7013.

Hewlett-Packard Company
United States of America

Rights for non-DOD U.S. Government Departments and Agencies are as set forth in FAR 52.227-19(c)(1,2).
Copyright Notices
©Copyright 2001-2005 Hewlett-Packard Development Company, L.P.

No part of this document may be copied, reproduced, or translated into another language without the prior
written consent of Hewlett-Packard Company. The information contained in this material is subject to change
without notice.

Trademark Notices.

Adobe® and Acrobat® are trademarks of Adobe Systems Incorporated.
HP-UX Release 10.20 and later and HP-UX Release 11.00 and later (in both 32
and 64-bit configurations) on all HP 9000 computers are Open Group UNIX 95
branded products.

Java™ is a U.S. trademark of Sun Microsystems, Inc.

Microsoft® is a U.S. registered trademark of Microsoft Corporation.
Netscape™ and Netscape Navigator™ are U.S. trademarks of Netscape
Communications Corporation.
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OpenView® is a registered U.S. trademark of Hewlett-Packard Company.

Oracle® is a registered U.S. trademark of Oracle Corporation, Redwood City,

California.

UNIX® is a registered trademark of the Open Group.

Windows NT® is a U.S. registered trademark of Microsoft Corporation.

Windows® and MS Windows® are U.S. registered trademarks of

Microsoft Corporation.

Microsoft® Internet Explorer is a registered trademark of Microsoft Corporation.

Itanium® and Pentium® are trademarks or registered trademarks of Intel Corporation or its subsidiaries in
the United States and other countries.

Certicom, the Certicom logo, SSL Plus, and Security Builder are trademarks of Ceticom Corp. Copyright ©
Certicom Corp. 2000-2004. All rights reserved.

Certicom, the Certicom logo, SSL Plus and Security Builder are trademarks or registered trademarks of
Certicom Corp. All other trademarks or registered trademarks are property of their respective owners. This
product is covered by one or more of the following U.S. Patents: US 6,195,433, 6,178,507, 6,141,420,
6,134,325, 6,122,736, 6,097,813, 6,078,667, 6,049,815, 5,999,626, 5,955,717, 5,933,504, 5,896,455,
5,889,865, 5,787,028, 5,761,305, 5,600,725, 4,745,568. Other applications and corresponding foreign
protection pending.

This product includes a copy of the Microsoft Data Engine (MSDE), redistributed under the terms of Microsoft's
End-User License Agreement.

Additional licenses can be found under <install dir>\license-agreements.

open-source Notices

This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.
openssl.org/).

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com).

This product includes software written by Tim Hudson (tjh@cryptsoft.com).

Additional open-source licenses can be found under <install dir>\license-agreements.

OpenLDAP Public License

The OpenLDAP Public License, Version 2.3, 28 July 2000

Redistribution and use of this software and associated documentation ('Software'), with or without
modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain copyright statements and notices.

2. Redistributions in binary form must reproduce applicable copyright statements and notices, this list of
conditions, and the following disclaimer in the documentation and/or other materials provided with the
distribution.

3. Redistributions must contain a verbatim copy of this document.

4. The name "OpenLDAP" must not be used to endorse or promote products derived from this Software
without prior written permission of the OpenLDAP Foundation.

5. Products derived from this Software may not be called "OpenLDAP" nor may "OpenLDAP" appear in their
names without prior written permission of the OpenLDAP Foundation.

6. Due credit should be given to the OpenLDAP Project ( http://www.openldap.org/).

7. The OpenLDAP Foundation may revise this license from time to time.
Each revision is distinguished by a version number. You may use the Software under terms of this license
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revision or under the terms of any subsequent revision of the license.

THIS SOFTWARE IS PROVIDED BY THE OPENLDAP FOUNDATION AND CONTRIBUTORS ~“AS IS" AND ANY
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
OPENLDAP FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

OpenLDAP is a trademark of the OpenLDAP Foundation.

Copyright 1999-2000 The OpenLDAP Foundation, Redwood City, California, USA. All Rights Reserved.
Permission to copy and distributed verbatim copies of this document is granted.

NetBSD C Library Source

Copyright (C) 1996-2002 Internet Software Consortium.

Permission to use, copy, modify, and distribute this software for any purpose with or without fee is hereby
granted, provided that the above copyright notice and this permission notice appear in all copies.

THE SOFTWARE IS PROVIDED "AS IS"™ AND INTERNET SOFTWARE CONSORTIUM DISCLAIMS ALL
WARRANTIES WITH REGARD TO THIS SOFTWARE INCLUDING ALL IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL INTERNET SOFTWARE CONSORTIUM BE LIABLE FOR
ANY SPECIAL, DIRECT, INDIRECT, OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER
RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE
OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF
THIS SOFTWARE.

$1d: COPYRIGHT,v 1.6.2.2 2002/02/12 06:05:48 marka Exp $
Portions Copyright (C) 1996-2001 Nominum, Inc.

Permission to use, copy, modify, and distribute this software for any purpose with or without fee is hereby
granted, provided that the above copyright notice and this permission notice appear in all copies.

THE SOFTWARE IS PROVIDED "AS IS" AND NOMINUM DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS
SOFTWARE INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL
NOMINUM BE LIABLE FOR ANY SPECIAL, DIRECT, INDIRECT, OR CONSEQUENTIAL DAMAGES OR ANY
DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF
CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE
USE OR PERFORMANCE OF THIS SOFTWARE.

©Copyright 2000 - 2005 Hewlett-Packard Development Company, L.P.
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